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Bevezetés 1
A fejezet tartalma
• Áttekintés: 1. oldal
• Támogatás: 3. oldal
• Támogatott készülékek: 3. oldal 
• Az útmutató használata: 5. oldal
• A felhasználó biztonsága: 6. oldal

Áttekintés

Köszönjük, hogy a Medtronic Diabetes termékét választotta 
a cukorbetegség hatékonyabb kezelése érdekében. Meggy z désünk, 

hogy a CareLink™ Pro szoftver korszer  megoldásait és egyszer ,
menüalapú felhasználói felületét hasznosnak fogja találni.

Ebb l a használati útmutatóból megtudhatja, hogy miként gy jthet k össze, 
menthet k és formálhatók jelentéssé a beteg terápiás és diagnosztikus 
adatai a CareLink Pro használatával. Megtudhatja azt is, hogy miként 
érhet  el a beteg által a pumpával, a mért értékekkel és a szenzor által 

mért glükózértékekkel összefüggésben a CareLink™ Personal rendszerbe 
feltöltött információ. Ez a rendszer egy, a CareLink Pro eszközzel 
együttm köd  webes terápiairányító felület.
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Szolgáltatások     

A CareLink Pro egy személyi számítógépeken futtatható szoftver 
a diabéteszterápia irányítására az alábbi szolgáltatásokkal:

• Betegnaplók hozhatók létre a beteg készülékéb l beolvasott adatok, 
valamint a beteg CareLink Personal-fiókjából beolvasott terápiaadatok 
tárolásához. 

• Az inzulinpumpáktól, a monitoroktól és a vércukormér kt l kapott 
adatok elküldhet k a rendszernek, menthet k, és jelentések 
készítéséhez is felhasználhatók.

• Lehet ség van a CareLink Personal rendszerrel történ  együttm ködésre
is, így a beteg által abban mentett készülékadatok is elérhet k. Mindez 
ideális megoldás a beteg egyes felülvizsgálatai közötti jelentések 
elkészítéséhez, így nem feltétlenül van szükség a készülékben tárolt 
adatok beolvasására a vizsgálatok során. 

• A betegnaplóban tárolt készülékadatokból különféle kezelési jelentések 
hozhatók létre. Ezek a jelentések segítenek megválaszolni a beteg 
együttm ködésével, a kezelési sémákkal és a kivételekkel kapcsolatos 
kérdéseket.

• A rendszer értesítést jelenít meg, ha letölthet  és telepíthet
szoftverfrissítések válnak elérhet vé. Ily módon biztosítható, 
hogy mindig a legújabb funkciókat lehessen használni. 

• Az útmutató segítségével a CareLink Pro használatában még 
nem jártas felhasználók is könnyebben eligazodhatnak, mert 
megjegyzéseket és tippeket nyújt a végrehajtandó feladatokhoz.

• A szoftver teljes egészében egy integrált súgórendszer nyújt információt 
a különböz  területekr l.

Biztonság     

• A CareLink Pro jelszavas védelemmel látható el.
• A beteg CareLink Personal felületr l származó adatainak átvitele 

SSL-alapú titkosítással történik.

Kapcsolódó dokumentumok     

A Medtronic MiniMed minden ilyen dokumentuma ebben a használati 
útmutatóban nem részletezett készülékinformációt tartalmaz. 

MEGJEGYZÉS: A más
gyártók mér eszközeivel
kapcsolatos tudnivalókat

a gyártók által mellékelt
dokumentáció

tartalmazza.

• A Paradigm inzulinpumpa használati útmutatója
• A Guardian REAL-Time monitor használati útmutatója
• A szenzorfunkciók használati útmutatója
• A ComLink használati útmutatója
• A CareLink USB használati útmutatója
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Támogatás

Ha további kérdései vannak a rendszerrel kapcsolatban, forduljon 
a helyi képviseletünkhöz. A nemzetközi elérhet ségeket a következ
címen olvashatja:

http://www.medtronicdiabetes.com/help/contact/locations.html

MEGJEGYZÉS:
A szoftver által

támogatott készülékek
némelyike nem

feltétlenül érhet  el
minden olyan

országban, ahol
a szoftver használatát

engedélyezték.

Támogatott készülékek

A CareLink Pro a következ  készülékekt l tud adatokat fogadni.           

Inzulinpumpák és vércukorszintmér k

Medtronic MiniMed pumpák 508

Medtronic MiniMed Paradigm sorozatú 
pumpák 

511, 512, 712, 515, 715, 522, 722, 522K, 
722K, Paradigm® REAL-Time Revel™

(523, 723, 523K, 723K),  Paradigm® Veo™

(554, 754)  

Guardian REAL-Time monitor CSS-7100
CSS-7100K

Gyártó Vércukorszintmér k     

Medtronic Diabetes 
partnerkészülékek

• Bayer CONTOUR® LINK
• LifeScan OneTouch® UltraLink™

• BD Paradigm Link® vércukorszintmér

LifeScan

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2
• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayer

• BREEZE™

• BREEZE™ 2
• CONTOUR®
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BD • Logic®

Bayer Ascensia® DEX®

termékcsalád, köztük ezen 
kompatibilis mér eszközök

• Ascensia® DEX®

• Ascensia® DEX® 2 
• Ascensia® DEXTER-Z® II
• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 
• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™

termékcsalád, köztük ezen 
kompatibilis mér eszközök

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™

• TheraSense FreeStyle®, FreeStyle Flash™

• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva
• Accu-Chek® CompactPlus
• Accu-Chek® Compact
• Accu-Chek® Active

Kommunikációs eszközök                 

 Com-Station

A MiniMed 508-as pumpához. 
(A szükséges hardverr l a Com-Station 
használati útmutatója nyújt részletes 
felvilágosítást.)

ComLink

A MiniMed Paradigm pumpához és 
a Guardian REAL-Time monitorhoz. 
(A szükséges hardverr l a ComLink 
használati útmutatója nyújt részletes 
felvilágosítást.) 

Paradigm Link® vércukorszintmér

A MiniMed Paradigm pumpához és 
a Guardian REAL-Time monitorhoz. 
(A szükséges hardverr l a Paradigm Link®

vércukorszintmér  használati útmutatója 
nyújt részletes felvilágosítást.)

CareLink™ USB
A MiniMed Paradigm pumpához és 
a Guardian REAL-Time monitorhoz.

Adatátviteli kábel
Küls  gyártók vércukorszintmér ihez. 
A gyártók saját adatátviteli kábelt 
mellékelnek készülékeikhez.

Gyártó Vércukorszintmér k     
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Helyettesít  készülékek       
A rendszer újabb készülékkel történ  b vítésekor a típust és 
a modellszámot egy listából kell kiválasztania. Ha nem találja 
a szóban forgó készülék típusát és modellszámát a listában, az 
alábbi táblázatból kiválaszthatja a megfelel  helyettesít  készüléket.

MEGJEGYZÉS:
A mér eszközöket

azok gyártójától
rendelheti meg.

Megrendelés                       

A Medtronic Diabetes termékeinek megrendeléséhez forduljon a helyi 
képviseletünkhöz. A Medtronic nemzetközi elérhet ségeit a következ
címen olvashatja:

http://www.medtronicdiabetes.com/help/contact/locations.html

Az útmutató használata

A szószedetben megtalálja a kifejezések és a funkciók meghatározását. 
Az útmutatóban használt kifejezések jelentését a következ  táblázat 
tartalmazza.

A használati útmutatóban szoftverképerny -minták is helyet kaptak. 
A szoftver tényleges képerny inek tartalma némileg eltérhet a jelen 
dokumentumban látottaktól.

A beteg által használt készülék Választható készülék

• Bayer Ascensia® DEX®

• Bayer Ascensia® DEX® 2
• Bayer Ascensia® DEXTER-Z® II
• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2 
• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™

Kifejezés és stílus Jelentés

Kattintás A képerny  objektumai fölött a bal egérgombbal kattintva 
kijelölhet k az objektumok. 

Dupla kattintás A képerny  objektumai fölött a bal egérgombbal duplán 
kattintva megnyithatók az objektumok.

Kattintás a jobb 
gombbal

A képerny  objektumai fölött a jobb egérgombbal 
kattintva másik ablak vagy menü jeleníthet  meg.

Félkövér szöveg
Menüelemet vagy menübeli elérési utat jelöl. 
Például: Patient > New Patient (Beteg > Új beteg)
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A felhasználó biztonsága

Alkalmazási terület 

A CareLink Pro rendszer célja, hogy a cukorbetegség kezeléséhez 
hatékony eszközt biztosítson. Rendeltetése az, hogy fogadja az 
inzulinpumpáktól, vércukorszintmér kt l és a vércukor szintjét 
folyamatosan figyel  rendszerekt l érkez  adatokat, és azokat 
CareLink Pro-alapú jelentésekké alakítsa. Ezekkel a jelentésekkel 
azonosíthatók a kialakult trendek, és nyomon követhet k a napi 
tevékenységek (például az elfogyasztott szénhidrátok, az étkezési 
id pontok, az inzulin beadásának id pontjai és a vércukorszint 
leolvasásának id pontjai). 

Figyelmeztetések 

• A rendszert csak a cukorbetegség kezelésének módját ismer
szakorvos használhatja. 

• A rendszer által adott eredmények nem képezhetik orvosi tanácsadás 
alapját. 

• A terméket kizárólag a jelen dokumentumban felsorolt támogatott 
készülékekkel szabad használni. (Lásd: Támogatott készülékek, 
3. oldal.)

• Javasolt, hogy a beteg naponta legalább 4-6 alkalommal ellen rizze
vércukorszintjét.

• Szakorvosi egyeztetés nélkül a betegnek nem szabad módosítania 
a kezelés módját.

• A betegnek nem a vércukorszintszenzor eredményei, hanem a szakorvos 
iránymutatása és a vércukorszint mért értékei alapján kell döntenie 
a kezelés mikéntjér l.

NAGYBET S szöveg Gombot jelöl. Például: SAVE (Mentés)

D lt szöveg Képerny - és mez neveket jelöl. 
Például: a Reports (Jelentések) képerny

MEGJEGYZÉS: További információ.

FIGYELEM! Veszélyre hívja fel a figyelmet, amely a szoftver vagy 
a berendezés enyhe vagy közepes mérték  károsodását 
okozhatja.

VIGYÁZAT! Olyan lehetséges veszélyre hívja fel a figyelmet, amely 
halált vagy súlyos sérülést okozhat. Esetenként 
potenciális szöv dményekre vagy biztonsági 
szempontokra hívja fel a figyelmet.

Kifejezés és stílus Jelentés
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Ellenjavallatok 

A szoftvert csak a vonatkozó táblázatban említett készülékekkel szabad 
használni (további információ: Támogatott készülékek, 3. oldal).
A termék csak a cukorbetegség kezelésére szolgál.

A szoftver indítása el tt zárja be a számítógépen jelenleg m köd
következ  szoftvereket:

• CGMS® System Solutions™

• Solutions® Pumps & Meters 

• Guardian® Solutions®

• ParadigmPAL™

• CareLink™ Personal 

• Solutions® szoftver a CGMS® iPro termékhez
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Navigálás a rendszerben 2
A fejezet tartalma
• Áttekintés: 8. oldal
• A CareLink Pro megnyitása: 8. oldal
• Munkaterületek: 10. oldal
• A f menüsor: 12. oldal
• Eszköztár: 12. oldal
• Az útmutató: 13. oldal
• További információra utaló hivatkozások: 14. oldal
• Súgórendszer: 14. oldal

Áttekintés

Ebben a fejezetben megismerkedhet a CareLink™ Pro grafikus felhasználói 
felületével (GUI). A felhasználói felület a menükb l, egy eszköztárból, egy 
navigációs sávból, munkaterületekb l és egy útmutató ablakból épül fel. 

A CareLink Pro megnyitása

1 Kattintson duplán a CareLink Pro asztalon lév  ikonjára.

Ha a rendel i rendszer jelszó beírását kéri, megjelenik 
a bejelentkezési képerny .

 A CareLink Pro
ikonja az asztalon
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a. Írja be a jelszót a Password (Jelszó) mez be.

MEGJEGYZÉS:
A jelszavas védelem
a telepítési folyamat

során állítható
be választható
lehet ségként.

b. Kattintson a LOGIN (Bejelentkezés) gombra.

Megjelenik az indítóképerny .

2 A NEW PATIENT (Új beteg) ikonra kattintva új betegrekordot vehet fel, az 
OPEN PATIENT (Betegadatok megnyitása) ikonnal pedig megnyithatja 
a szükséges betegrekordot a betegek rendszerbeli listájáról.

        

f menük

aktív
munkaterület

beteglista megnyitásaúj beteg felvétele

navigációs sáv

állapotsor

a Reports (Jelentések)
munkaterület gombja

a Devices (Készülékek)
munkaterület gombja

a Profile (Profil)
munkaterület gombja

útmutató megjelenítése/
elrejtése
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Munkaterületek

MEGJEGYZÉS:
A munkaterületekr l

és azok használatáról
a jelen útmutató

többi fejezete nyújt
felvilágosítást.

Ha meg van nyitva egy betegrekord, a navigációs sáv valamelyik 
gombjára kattintva megjeleníthet  a kapcsolódó munkaterület. 
A felsorolt munkaterületekkel írhatók be vagy választhatók ki a beteghez 
köt d  CareLink Pro-feladatok végrehajtásához szükséges adatok.

• Profile (Profil): A betegadatok (például név és születési dátum) 
tárolására szolgál, és lehet vé teszi a beteg CareLink Personal-
fiókjához való csatlakozást is.

• Devices (Készülékek): A beteg készülékeinek olvasásához 
szükséges adatok tárolására szolgál.

• Reports (Jelentések): Lehet vé teszi a paraméterek kiválasztását, 
valamint a beteghez létrehozandó jelentések megadását.

Amíg nem vesz fel és nem ment egy profilt a szóban forgó beteghez, 
csak a Profile munkaterület használható. Csak a Profile és a Devices
munkaterület érhet  el, amíg nem ad hozzá a beteghez készülékeket.
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Munkaterületek

a Devices munkaterület

a Profile munkaterület

a Reports munkaterület

Profile

Devices

Reports
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A f menüsor

A lenti ábra a f menüb l elérhet  lehet ségeket szemlélteti. 
A menüparancsok egy része a nevük melletti billenty kombinációval is 
elérhet  (a New Patient parancs például a Ctrl+N kombinációval). Egyes 
menüparancsok a navigációs sávról vagy az eszköztárról is indíthatók.

Eszköztár

A CareLink Pro eszköztára lehet vé teszi a gyakran használt funkciók 
gyors elérését. Az eszköztár az alábbi gombokat tartalmazza.

Gomb Név Funkció

Add Patient 
(Beteg
hozzáadása)

Megnyitja a Profile munkaterületet, 
amelyen új betegrekord vehet  fel 
a rendszerbe.

Open Patient 
(Betegadatok 
megnyitása)

Megnyitja a Patient Lookup (Beteg 
keresése) táblázatot, amelyben 
kiválaszthatók megtekintésre a már 
meglév  betegrekordok.

Guide Me 
(Útmutató)

Megjeleníti vagy elrejti az útmutatót. Erre 
a gombra kattintva környezetfügg  súgó 
jeleníthet  meg. 



CareLink Pro™ – használati útmutató    Navigálás a rendszerben      13

Betegrekordlapok

Egy adott betegrekord megnyitását követ en egy, a beteg nevét 
feltüntet  lapfül jelenik meg az eszköztár mentén. Ha egy lap aktív, 
akkor a kapcsolódó betegrekord és munkaterület is aktív, és 
végrehajthatók a beteggel összefügg  CareLink Pro-feladatok.

A betegrekord aktívvá tételéhez kattintson a betegrekord lapjának 
fülére. A rekord a lapfül CLOSE gombjára kattintva zárható be.

Az útmutató

A CareLink Pro szoftver teljes egészében segítségül hívható az 
útmutató, amelynek ablakában környezetfügg  megjegyzések és 
tippek találhatók az aktív rendszerösszetev  használatához. Az 
útmutató ablakában esetenként >> learn more (további tudnivalók) 
szöveg , további információra utaló hivatkozások is láthatók. 
E hivatkozásokra kattintva az online súgó b vebb tájékoztatást 
tartalmazó megfelel  része nyílik meg. Az útmutató alapértelmezés 
szerint engedélyezett, de bármikor ki is kapcsolható.

CLOSE
(Bezárás) gomb 

inaktív lap aktív lap

A Close (Bezárás)
gomb
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Az útmutató be- és kikapcsolása 

Gomb használatával

• Az útmutató be- vagy kikapcsolásához kattintson a GUIDE ME 
(Útmutató) gombra.

Menü használatával

• Az útmutató engedélyezéséhez vagy letiltásához válassza 
a Help > Guide Me (Súgó > Útmutató) lehet séget.

További információra utaló hivatkozások

A további információra utaló („learn more” szöveg ) hivatkozások az 
online súgórendszer kapcsolódó témaköreire mutatnak. A rendszer 
teljes egészében fellelhet k, az útmutatóban és a szoftverben egyaránt. 
Ha nem tudja, hogyan lépjen tovább egy adott m veletsorban, illetve 
hogy milyen értékeket kell beírnia, kattintson a >> learn more (további 
tudnivalók) hivatkozásra.

Súgórendszer

A CareLink Pro használata során súgórendszer segíti a felhasználót: 
azt ismerteti, hogy miként hajthatók végre a különböz  feladatok 
a szoftverben. 

A súgórendszer a következ  módokon nyitható meg:

• Válassza a Help > Medtronic CareLink Pro Help
(Súgó > A Medtronic CareLink Pro súgója) lehet séget. 

• Nyomja meg az F1 funkcióbillenty t.

A Guide Me
(Útmutató) gomb

további információra utaló hivatkozás
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Els  lépések 3
A fejezet tartalma
• Miel tt hozzákezdene…: 15. oldal
• A betegek rekordjainak megnyitása és bezárása: 17. oldal
• Rendszerbeállítások megadása: 18. oldal 

Ez a fejezet a CareLink™ Pro szoftver elindítását, a betegek rekordjainak 
megnyitását és bezárását, valamint a rendszer minden betegére 
érvényes beállításokat mutatja be. 

Miel tt hozzákezdene…

Ha most használja el ször a CareLink Pro szoftvert, mindenképpen 
adja meg az általános beállításokat (lásd: Általános beállítások, 
18. oldal). Ezek a beállítások határozzák meg, hogy bizonyos elemek 
hogyan jelenjenek meg a szoftverben és a jelentésekben, és ezek 
segítségével állíthatja be a rendszer internettel való kommunikációját.

Ezeket a beállításokat bármikor elvégezheti, ezért érdemes a többi 
beállítás megadása el tt megismerkedni a CareLink Pro szoftverrel.
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Els dleges rendszerfeladatok

Az alábbi táblázat ismerteti a CareLink Pro els  beállítása és 
használata során elvégzend  f bb feladatokat. A táblázatból az is 
kiderül, hogy a használati útmutató melyik része foglalkozik az adott 
feladattal.

Lépés Hely

Ismerkedés a CareLink Pro felhasználói 
felületével 2. fejezet: Navigálás a rendszerben

Az Ön rendel je által használt globális 
rendszerbeállítások megadása

Rendszerbeállítások megadása, 
18. oldal

Profil létrehozása minden beteg számára Új profilok hozzáadása, 25. oldal

Kapcsolódás a betegek CareLink 
Personal-fiókjaihoz

Kapcsolat létrehozása a CareLink 
Personal szoftverrel (választható), 
26. oldal

Pumpák és mér eszközök hozzáadása 
a beteg profiljához Készülék hozzáadása, 35. oldal

Adatok beolvasása a beteghez tartozó 
pumpákról és mér eszközökr l

A készülék adatainak beolvasása, 
41. oldal

Jelentések beállítása és elkészítése 
az egyes betegekr l

Jelentések létrehozása, 44. oldal

Rendszeres biztonsági másolat 
készítése a CareLink Pro adatbázisáról

Adatbázis biztonsági mentése, 
57. oldal

A CareLink Pro szoftver frissítése
A szoftverfrissítések telepítése, 
56. oldal
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A betegek rekordjainak megnyitása és bezárása

A betegek rekordjainak megnyitása         
Összesen hat betegrekord lehet nyitva egyszerre. Ha még nem hozott 
létre profilokat, olvassa el ezt a részt: Új profilok hozzáadása, 25. oldal.

1 Válassza a File > Open Patient (Fájl > Betegadatok megnyitása) 
parancsot, vagy kattintson az OPEN PATIENT gombra. Az alábbihoz 
hasonló beteglista jelenik meg.

MEGJEGYZÉS: Ha az
az üzenet jelenik meg,

hogy túl sok rekord van
nyitva, a folytatás el tt

kattintson az OK
gombra, majd zárjon

be egy rekordot.

2 A beteg nevének vagy neve egy részének beírásával keresse meg 
a beteget a Find a Patient (Beteg keresése) mez ben. Ha a beteghez 
tartozó sor ki van jelölve, kattintson az OPEN (Megnyitás) gombra, 
kattintson duplán a lista kijelölt sorára, vagy nyomja le az ENTER billenty t. 
A billenty zet felfelé és lefelé mutató nyílbillenty ivel is lépkedhet 
alista elemei között. 
Ekkor a beteghez tartozó Devices (Készülékek) munkaterület (ha nem 
állított még be készüléket) vagy a Reports (Jelentések) munkaterület 
jelenik meg.

3 A beteghez tartozó Profile (Profil) munkaterület megjelenítéséhez 
kattintson a PROFILE gombra.

A betegek rekordjainak bezárása        

1 Gy z djön meg arról, hogy a bezárni kívánt rekord aktív (a lap ki 
van jelölve).

2 A következ  lehet ségek közül választhat:
a. Válassza a File > Close Patient (Fájl > Betegadatok bezárása) 

parancsot.
b. A beteghez tartozó fülön kattintson a CLOSE (Bezárás) gombra.
c. Nyomja le a Ctrl+F4 billenty kombinációt.

Open Patient
(Betegadatok
megnyitása)

gomb

A Profile (Profil) gomb

A Close (Bezárás) gomb
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Rendszerbeállítások megadása

Ezek a beállítások a rendszerben szerepl  minden betegre vonatkoznak. 
A csak bizonyos betegeket érint  beállításokról a következ  helyen 
talál tudnivalókat: Jelentés beállításainak ellen rzése, 48. oldal.

A beállítások az alábbi csoportosításban jelennek meg:

• General (Általános)

– Glucose units (Vércukor mértékegysége)
– Carbohydrate units (Szénhidrát mértékegysége)
– Communications (Kommunikáció)
– Troubleshooting (Hibaelhárítás)

• Patient Profile (Betegprofil)

– A betegek profiljain szerepl  adatok kiválasztása és szerkesztése
• Patient Lookup (Beteg keresése)

– Az Open Patient parancs nyomán megjelen  beteglistán szerepl
mez k sorrendjének módosítása

• Report Generation (Jelentés készítése)

– Az adattábla adatai alapján a Daily Detail (Részletes napi) 
jelentésben megjeleníteni kívánt adatok

Általános beállítások  

1 Válassza a Tools > Options (Eszközök > Beállítások) parancsot. 
Megjelenik az alábbi ablak.
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2 A választógomb segítségével jelölje ki a kívánt értéket:

– Glucose Units: mg/dl vagy mmol/l
– Carbohydrate Units: grams (gramm) vagy Exchanges (Csereegység)
a. Ha a Carbohydrate Units beállításhoz az Exchanges értéket 

választotta, írja be a megfelel  számot a grams are equal to 
1 Exchange (gramm egyenl  egy csereegységgel) mez be.

3 Jelölje be a Communications csoport alábbi jelöl négyzeteit az 
engedélyezéshez, vagy törölje azok jelölését a tiltáshoz:

MEGJEGYZÉS:
A kommunikációval

kapcsolatos beállítások
elvégzése során vegye

figyelembe a rendel
vagy az intézmény

informatikai részlegének
irányelveit.

– Automatically check for software updates (Szoftverfrissítések 
automatikus keresése): Engedélyezésével minden CareLink Pro 
szoftvert futtató rendszer értesítést kap, ha van elérhet
szoftverfrissítés. Ekkor az aktív felhasználók letölthetik és 
telepíthetik a frissítéseket. A szolgáltatás kikapcsolásához és 
a szoftverfrissítések telepítésének közvetlen irányításához törölje 
a jelölést a jelöl négyzetb l.

– Synchronize with CareLink™ Personal (Szinkronizálás 
a CareLink™ Personal szoftverrel): Ha meg szeretné adni, 
hogy a rendszer a profil minden megnyitásakor automatikusan 
szinkronizálja a beteg CareLink Personal által kezelt adatait, jelölje 
be a Synchronize with CareLink Personal jelöl négyzetet. Ha törli 
a jelölést, kézzel kell majd szinkronizálnia minden egyes beteg 
adatait a CareLink Personal adataival.

4 Kattintással jelölje be a Troubleshooting csoport jelöl négyzetét, 
vagy törölje annak jelölését. Ha a jelöl négyzet be van jelölve, az 
alkalmazás a készülékadatok minden beolvasásakor hibaelhárítás 
céljából menteni fog egy adatrekordot.

5 Az általános beállítások mentéséhez kattintson az OK gombra. 
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A betegprofilok beállításai         

1 Válassza a Tools > Options parancsot. 

2 Kattintson a Patient Profile fülre. Megjelenik az alábbi ablak.

Az adatmez k kiválasztása  

1 A kívánt mez ket a jelöl négyzetek segítségével adhatja hozzá.

MEGJEGYZÉS:
A First name

(Keresztnév) és a Last
Name (Vezetéknév)

mez t nem lehet
eltávolítani.

2 Egy mez  eltávolításához törölje a jelölést a mez  melletti 
jelöl négyzetb l.

3 Egy mez  kötelez  felvételéhez jelölje be a Required (Kötelez )
oszlopban található jelöl négyzetet. Az összes kötelez  mez t ki 
kell tölteni a profil létrehozásához.

Egyéni mez  hozzáadása         

1 Jelölje be valamelyik üres egyéni mez  bal oldalán található 
jelöl négyzetet.

2 Nevezze el a mez t (pl. Vészhelyzeti elérhet ségek). A mez  ezzel 
a névvel szerepel majd a beteg profilján.

3 A mez  kötelez vé tételéhez jelölje be a Required oszlopban található 
jelöl négyzetet.

A jelöl négyzetek segítségével adja meg a profilon megjeleníteni kívánt mez ket.
A felfelé és lefelé mutató nyilak segítségével rendezze sorba a mez ket.
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MEGJEGYZÉS: Egyéni
mez  eltávolításához

törölje a jelet az adott
mez  jelöl négyzetéb l.

Az adatmez k sorrendjének megváltoztatása         

• Jelölje ki az áthelyezni kívánt mez t, majd a felfelé és lefelé mutató 
nyilak segítségével mozgassa azt. (A legfels  és a legalsó nyíl a lista 
tetejére, illetve aljára helyezi át az adott mez t.)

A betegprofil beállításainak véglegesítése

• Ha a Field Order (Mez sorrend) listán az egyes mez k a kívánt 
sorrendben szerepelnek, kattintson az OK gombra.

A betegprofilok ekkor az Ön által megadott mez kkel és mez sorrenddel 
rendelkeznek.

A betegkeresés beállításai         

1 Válassza a Tools > Options parancsot. 

2 Kattintson a Patient Lookup fülre. Megjelenik az alábbi ablak.

A megjeleníteni kívánt adatok kiválasztása 

• A jelöl négyzetek segítségével adja meg a Patient Lookup táblázatban 
megjeleníteni kívánt adatok típusát, vagy törölje azokat, melyekre 
nincs szüksége.

Fel/le
 nyilak

A jelöl négyzetek segítségével adja meg a Patient Lookup táblázatban megjeleníteni 
kívánt adatokat. A felfelé és lefelé mutató nyilak segítségével rendezze sorba az oszlopokat.
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MEGJEGYZÉS: A First
name és a Last Name

mez t nem lehet
eltávolítani.

Az oszlopok sorrendjének megváltoztatása  

• A Patient Lookup táblázat oszlopsorrendjének megváltoztatásához 
jelölje ki az áthelyezni kívánt oszlopot, majd a fel- és lefelé mutató 
nyilakkal mozgassa azt. (A legfels  és a legalsó nyíl a lista tetejére, 
illetve aljára helyezi át az adott adatoszlopot.)

MEGJEGYZÉS:
A Column Display Order
(Oszlopok megjelenítési

sorrendje) csoport
legfels  adatoszlopa

lesz a Patient Lookup
(Beteg keresése)

táblázat els  oszlopa.
Az alsó adatoszlop lesz

a táblázat utolsó
oszlopa.

A betegkeresés beállításainak véglegesítése

• Ha a Column Display Order listában az egyes adatok a kívánt 
sorrendben szerepelnek, kattintson az OK gombra.

A Patient Lookup táblázat ekkor az Ön által megadott adatokkal és 
oszlopsorrenddel rendelkezik.

A jelentéskészítéssel kapcsolatos beállítások  

Az adattábla a jelentéskészítés kiválasztási lépése során jelenik meg. 
Ez a tábla azokat az adatokat tartalmazza, melyek alapján a kezel orvos 
eldöntheti, hogy milyen dátumokhoz tartozó Daily Detail jelentéseket 
kíván megtekinteni.

MEGJEGYZÉS: Azzal
kapcsolatban, hogy

ezek a beállítások
hogyan lesznek az

adattáblára alkalmazva
jelentéskészítéskor,
a következ  helyen

talál információt:
Jelentéstípusok és

felvenni kívánt dátumok
kiválasztása, 50. oldal.

1 Válassza a Tools > Options parancsot. 

2 Kattintson a Report Generation fülre. Megjelenik az alábbi ablak.

Fel/le
 nyilak

A jelöl négyzetek segítségével adja meg az adattáblában megjeleníteni kívánt 
adattípusokat. A felfelé és lefelé mutató nyilak segítségével rendezze sorba az oszlopokat.
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A megjeleníteni kívánt adatok kiválasztása        

• A jelöl négyzetek segítségével adja meg az adattáblába felvenni 
és az abból eltávolítani kívánt adattípusokat.

Az oszlopok sorrendjének megváltoztatása         

• Az adattábla oszlopsorrendjének megváltoztatásához jelölje ki az 
áthelyezni kívánt oszlopot, majd a fel- és lefelé mutató nyilakkal 
mozgassa azt. (A legfels  és a legalsó nyíl a lista tetejére, illetve 
aljára helyezi át az adott oszlopot.)

MEGJEGYZÉS:
A Column Order

(Oszlopok sorrendje)
lista legfels  eleme lesz

az adattábla els
oszlopa. Az alsó elem

lesz a tábla utolsó
oszlopa.

A jelentéskészítéssel kapcsolatos beállítások véglegesítése

• Ha a Column Order listában az egyes adatok a kívánt sorrendben 
szerepelnek, kattintson az OK gombra. 

Az adattábla ekkor az Ön által megadott adatokkal és 
oszlopsorrenddel rendelkezik.

Fel/le
 nyilak



CareLink Pro™ – használati útmutató    A Profile (Profil) munkaterület      24

A Profile (Profil) 
munkaterület 4
A fejezet tartalma
• Miel tt hozzákezdene…: 24. oldal
• Új profilok hozzáadása: 25. oldal
• Betegprofilok szerkesztése: 25. oldal
• A beteg adatainak törlése a rendszerb l: 25. oldal
• Kapcsolat létrehozása a CareLink Personal szoftverrel (választható): 

26. oldal

A profil az orvosok által használt kórlap fed lapjához hasonlít, és a beteg 
adatait (például a nevét és a születési dátumát) tárolja. A profil szükséges 
a készülék adatainak összegy jtéséhez és a terápiás jelentések 
elkészítéséhez.

A Profile munkaterület arra is alkalmas, hogy segítségével kapcsolódjon 
a beteg CareLink Personal-fiókjához. Amint a kapcsolat létrejött, 
a beteg CareLink Personal által tárolt adataihoz a beteg személyes 
jelenléte nélkül is bármikor hozzá lehet férni.

Miel tt hozzákezdene…

A betegprofilok testreszabhatók annak érdekében, hogy csak az Ön 
által igényelt információkat tartalmazzák. További információkat 
a következ  helyen talál: A betegprofilok beállításai, 20. oldal.

Ha létre kívánja hozni a kapcsolatot a beteg CareLink Personal-fiókjával, 
szükség van felhasználónévre és jelszóra is. Ezen adatok megadása 
a beteg személyes jelenléte mellett történik.
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Új profilok hozzáadása

Minden egyes beteg CareLink Pro rendszerbe történ  felvétele el tt 
ki kell tölteni egy profilt. 

1 Válassza a File > New Patient (Fájl > Új beteg) parancsot, vagy 
kattintson az ADD PATIENT (Beteg hozzáadása) gombra. 

Megjelenik a Profile munkaterület (lásd a példát: 11. oldal).

MEGJEGYZÉS: Mez k
hozzáadásához vagy

módosításához a beteg
profilján kattintson

a >> customize fields
(mez k testreszabása)

elemre (lásd:
A betegprofilok

beállításai, 20. oldal).

2 Töltse ki a Patient Profile (Betegprofil) csoportban található mez ket. 

3 Kattintson a SAVE (Mentés) gombra.

A program hozzáadja az új betegprofilt a CareLink Pro adatbázisához, 
amit a képerny n megjelen  üzenet is meger sít.

Ha egy kötelez  mez  nincs kitöltve a betegprofil mentésekor, egy 
üzenet jelenik meg a kitöltend  mez  mellett. A profil mentése csak 
akkor lehetséges, ha a mez  ki van töltve.

Betegprofilok szerkesztése

1 Gy z djön meg arról, hogy az adott beteghez tartozó Profile munkaterület 
meg van nyitva.

2 Kattintson az EDIT (Szerkesztés) gombra.

3 Szükség szerint módosítsa a Patient Profile szakasz adatait.

4 Kattintson a SAVE gombra.

A megjelen  üzenet meger síti a profil mentését.

A beteg adatainak törlése a rendszerb l

1 Gy z djön meg arról, hogy az adott beteghez tartozó Profile
munkaterület meg van nyitva. 

2 Ellen rizze, hogy valóban a törölni kívánt beteg adatai szerepelnek-e 
képerny n. A betegprofil törlésével a beteg összes adata 
visszavonhatatlanul törl dik a CareLink Pro adatbázisából is.

3 Kattintson a profil szinkronizálási szakasza feletti >> delete patient 
record (betegrekord törlése) elemre.

Figyelmeztet  üzenet jelzi, hogy a rekord törlésekor a beteg minden 
adata törl dni fog. 

4 A beteg rekordjának törléséhez kattintson a YES (Igen) gombra.

Az Add Patient (Beteg
hozzáadása)
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Kapcsolat létrehozása a CareLink Personal 
szoftverrel (választható)

A beteg beleegyezésével kapcsolatot hozhat létre a beteg CareLink 
Personal-fiókjával. Ennek a web alapú eszköznek a segítségével 
a betegek feltölthetik és tárolhatják a készülékb l nyert adatokat, 
valamint különböz  terápiás jelentéseket futtathatnak. 

Ha kapcsolódik a beteg CareLink Personal-fiókjához, hozzáférhet 
az ott tárolt, a CareLink Pro jelentéseinek létrehozásához használt 
készülékadatokhoz. A jelentések bármikor, akár két vizsgálat között 
is elkészíthet k, valamint kevesebbszer kell leolvasnia a készüléket 
a beteg látogatásai során.

Ha a betegnek még nincs CareLink Personal-fiókja, küldhet neki meghívó 
e-mailt, melynek segítségével a beteg létrehozhatja saját fiókját. 

Kapcsolat létrehozása meglév  fiókkal  

MEGJEGYZÉS:
E lépésekhez a beteg

személyes jelenléte
szükséges.

1 Ellen rizze az internetcsatlakozást.
2 Nyissa meg a beteghez tartozó Profile munkaterületet. 
3 Gy z djön meg arról, hogy minden szükséges mez  ki van töltve 

a Patient Profile csoportban.
4 Kattintson a LINK TO EXISTING ACCOUNT (Kapcsolódás meglév

fiókhoz) parancsra. 
Megjelenik a CareLink Personal beléptet  képerny je.

5 Kérje meg a beteget az alábbiakra:
a. Írja be a felhasználónevét és a jelszavát.
b. Kattintson a SIGN IN (Bejelentkezés) gombra. 
Megjelenik a beteg területi és nyelvi beállításait alapul vev  Grant of 
Access (Hozzáférés engedélyezése) képerny .
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6 Kérje meg a beteget az alábbiakra:

a. Olvassa el a felhasználási feltételeket.
b. Jelölje be az I agree to the Terms of Use above… (Elfogadom 

a fent ismertetett felhasználási feltételeket) jelöl négyzetet. 
c. Kattintson a GRANT ACCESS (Hozzáférés engedélyezése) gombra.
d. Jelezze, ha a Thank You (Köszönöm) képerny  megjelenik.
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A felhasználási feltételeket ki is nyomtathatja a beteg számára, 
ha a PRINT (Nyomtatás) gombra kattint.

Ezzel sikeresen kapcsolódott a beteg CareLink Personal-fiókjához. 
További tudnivalókat a következ  helyen talál: Adatok beolvasása 
kapcsolattal rendelkez  fiókból, 29. oldal.

E-mail meghívó küldése           

Ha meghívó e-mailt kíván küldeni a betegnek CareLink Personal-fiók 
létrehozása céljából, végezze el a következ  lépéseket:

1 Nyissa meg a beteghez tartozó Profile munkaterületet. 

2 Gy z djön meg arról, hogy minden szükséges mez  ki van töltve 
a Patient Profile csoportban.

3 Kattintson a SEND E-MAIL INVITATION TO PATIENT (Meghívó e-mail 
küldése a betegnek) gombra.

4 Gy z djön meg arról, hogy a Patient Name (Beteg neve), az Email és 
a Language (Nyelv) mez k helyesen vannak kitöltve.

5 Kattintson a SEND (Küldés) gombra. 

A betegprofil állapotterületén a program meger síti, hogy az e-mail 
elküldése megtörtént.
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A beteg CareLink Personal-fiókja és a CareLink Pro közötti kapcsolat 
megszüntetése

A beteg CareLink Personal-fiókja és a CareLink Pro közötti kapcsolatot 
megszüntetheti. Ez a lehet ség csak akkor érhet  el, ha korábban 
a kapcsolatot létrehozta. A kapcsolat megszüntetésével megel zhet ,
hogy a CareLink Pro továbbra is adatokat kérdezzen le a beteg 
CareLink Personal-fiókjából, ugyanakkor az eljárás nem érinti a beteg 
saját CareLink Personal-fiókjával kapcsolatos egyéb m veleteit.

1 Nyissa meg a beteg rekordját, és váltson a Profile munkaterületre.

2 Kattintson az UNLINK ACCOUNT (Fiók kapcsolatának 
megszüntetése) parancsra.

3 A meger sít  üzenet megjelenésekor kattintson a Yes gombra. 
A beteg profiljának kapcsolata megsz nt a CareLink Pro szoftverrel.

Az állapot Not linked (Nincs kapcsolat) értékre vált, valamint a LINK TO 
EXISTING ACCOUNT és a SEND E-MAIL INVITATION TO PATIENT 
gombok ismét megjelennek.

Adatok beolvasása kapcsolattal rendelkez  fiókból            

Ha kapcsolata van egy beteg CareLink Personal-fiókjával, a rendszer 
automatikusan elküldi a fiókban lév  új adatokat a betegprofil 
CareLink Pro alkalmazásban történ  minden megnyitásakor. 

MEGJEGYZÉS: Hogy ez
biztosan megtörténjen,

gy z djön meg arról,
hogy a Tools > Options >

General (Eszközök >
Beállítások > Általános)

lapon be van jelölve
a Synchronize with
Medtronic CareLink

Personal (Szinkronizálás
a Medtronic CareLink
Personal szoftverrel)

jelöl négyzet.

Azt, hogy a profil minden megnyitásakor megtörténjen a beteg 
CareLink Personal által kezelt adatainak beolvasása, 
a következ képpen állíthatja be:

1 Gy z djön meg arról, hogy a beteghez tartozó Profile munkaterület 
meg van nyitva, és ellen rizze az internetcsatlakozást.

2 Válassza a Tools > Synchronize Patient Data (Eszközök > 
Betegadatok szinkronizálása) parancsot.

A szinkronizálás ikonja forogni kezd a beteg lapján. Amikor az ikon 
megáll, a folyamat véget ért.

MEGJEGYZÉS:
Ha a beteg már nem

járul hozzá a CareLink
Personal által

kezelt adatainak
megosztásához,

kikapcsolhatják ezt
a funkciót az OPTIONS

menüb l. Err l egy
tájékoztató üzenet

jelenik meg.

3 A CareLink Personal által kezelt további adatok szerepelni fognak 
a betegr l szóló jelentésekben. 

A szinkronizálás ikonja
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A hardver beállítása 5
A fejezet tartalma
• Miel tt hozzákezdene…: 30. oldal
• A készülékek csatlakoztatása: 31. oldal

Az e fejezetben található ábrák segítségével beállíthatja a beteg 
készülékét, hogy a számítógép adatokat fogadhasson arról.

A közvetlen adatbeolvasáshoz szükség van a beteg készülékére, 

de a készüléken tárolt adatok a beteg CareLink™ Personal-fiókjából 
a készülék nélkül is beolvashatók.   

Miel tt hozzákezdene…

A közvetlen adatbeolvasáshoz szükség van a beteg készülékére, 
valamint a készülék adatainak a számítógépre való továbbításához 
szükséges kábelekre és egyéb kommunikációs eszközökre.
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A készülékek csatlakoztatása

MEGJEGYZÉS:
Részletesebb

információkért kövesse
a CareLink™ Pro által

a készülék beolvasásakor
megjelenített utasításokat.

Az áttekint  ábra általános képet ad arról, hogy a készülékeket hogyan 
kell a számítógéphez csatlakoztatni a kommunikáció létrehozásához. 
A további ábrák a készülékek kommunikációjának egyedi jellemz it
ismertetik. 

MEGJEGYZÉS: Ezen az
ábrán például látható,

hogy a pumpa és
a számítógép közötti

kommunikáció
a CareLink USB

segítségével történik.

A hardverbeállítás áttekintése               

TM

CareLinkUSB

CareLink USB

számítógép

Paradigm pumpa
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Hardvercsatlakoztatási ábrák                                    

                      

A számítógép csatlakozói

USB
port

soros
port
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csatlakoztatás
a számítógép

soros portjára

ComLink a Paradigm pumpákhoz

Kiegészít  tartozékok

Com-Station a MiniMed 508-as pumpák és a mér eszközök
átmen  adatai számára
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A Devices (Készülékek) 
munkaterület 6
A fejezet tartalma
• Miel tt hozzákezdene…: 35. oldal
• Készülék hozzáadása: 35. oldal
• A készülék aktiválása és inaktiválása: 40. oldal 
• A készülék adatainak beolvasása: 41. oldal

A beteg készülékének (típus, modell, sorozatszám stb.) beolvasásához 
szükséges adatokat a Devices munkaterület tartalmazza. Következésképpen, 
ezeket az információkat nem kell megadnia minden alkalommal, amikor 
adatokat olvas le a készülékr l.

A Devices munkaterületen tárolt készülékek a következ  két listában 
jelennek meg: Active Devices (Aktív készülékek) vagy Inactive Devices
(Inaktív készülékek). Készülék hozzáadásakor az automatikusan az 
Active Devices listába kerül. Csak az Active Devices listában megjelen
készülékekr l olvashatók le adatok. Ezek valószín leg a beteg által 
jelenleg használt készülékek lesznek. 

A beteghez tartozó egyéb készülékeket, amelyek használaton kívül 
vannak, az Inactive Devices listában lehet tárolni. E módszerrel 
meg rizhet k az információk. A készülékeket bármikor aktiválni lehet.
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Miel tt hozzákezdene…

Ahhoz, hogy megnyithassa a beteg Devices munkaterületét, a betegnek 
a rendszerben mentett profillal kell rendelkeznie. Lásd: 4. fejezet: 
A Profile (Profil) munkaterület.

Készülék hozzáadásához vagy a készülékr l történ  közvetlen 
adatbeolvasáshoz a készüléknek kommunikálnia kell a számítógéppel. 
A készülékek számítógéppel történ  kommunikációjához szükséges 
beállításainak leírása itt olvasható: 5. fejezet: A hardver beállítása.

Készülék hozzáadása

Ha még nincs hozzáadva a készülék, az adatokat a beteg CareLink 
Personal-fiókjából lehet beolvasni. E készülékeket a rendszer 
automatikusan felveszi a CareLink Personal és a CareLink Pro 
közötti adatszinkronizáláskor.

MEGJEGYZÉS:
Betegenként csak

egyetlen aktív pumpa
lehet a rendszerben.

Újabb pumpa
hozzáadásakor a már

felvett átkerül az inaktív
készülékek listájába.

Medtronic pumpa vagy Guardian monitor hozzáadása          
1 Gy z djön meg arról, hogy a hozzáadni kívánt készülék beállítása 

lehet vé teszi a kommunikációt a számítógéppel. (A kapcsolódás 
lépéseir l itt olvashat: 5. fejezet: A hardver beállítása.)

2 Kattintson a beteg adatait jelz  fülre, vagy kattintson duplán a beteg 
nevére a Patient Lookup (Beteg keresése) táblázatban.

3 Kattintson a DEVICES (Készülékek) gombra a beteghez tartozó 
Devices munkaterület eléréséhez (a vonatkozó példa itt olvasható: 
11. oldal).

4 Kattintson az ADD DEVICE (Készülék hozzáadása) gombra.

5 Válassza a Medtronic Pump/Guardian lehet séget. Megjelenik az 
Add Medtronic Pump/Guardian Wizard (Medtronic pumpa/Guardian 
hozzáadása varázsló).

A DEVICES (Készülékek)
gomb
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MEGJEGYZÉS:
A pumpa modellszáma

a pumpa hátán vagy
a pumpa állapotát jelz

képerny n olvasható.

6 A választógomb segítségével jelölje ki a hozzáadni kívánt készüléket. 

Ha a MiniMed 508 pump lehet séget választotta, ugorjon a 9. lépésre.

7 Kattintson a NEXT (Tovább) gombra. Megjelenik a Serial Number
(Sorozatszám) oldal.

MEGJEGYZÉS: Ha nem
adja meg a helyes

sorozatszámot,
hibaüzenet jelenik meg.

Tekintse át az oldalon
látható példákat, és

gy z djön meg arról,
hogy a pumpa

hátoldaláról a helyes
karaktereket adja meg.

Szükség esetén gépelje
be újra a hat karaktert.

8 Az oldalon látható példák segítségével azonosítsa a hozzáadni kívánt 
készüléken lév  és hat karakterb l álló sorozatszámot. (Ha az 
azonosításhoz további segítségre van szüksége, a részletekhez 
kattintson a >> learn more (további tudnivalók) elemre.) Írja be a hat 
karaktert a Device Serial Number (Készülék sorozatszáma) mez be.

9 Kattintson a NEXT gombra. Az alábbihoz hasonló Communication 
Options (Kommunikációs beállítások) lap jelenik meg.

10 A Choose Port (Port kiválasztása) legördül  menüb l válassza azt 

a portot, amelyre a ComLink, a Paradigm Link®, a CareLink USB 
vagy a Com-Station kapcsolódik az Ön számítógépén. Ha nem biztos 
abban, hogy melyik port a megfelel , válassza az Auto Detect (or USB)
(Automatikus észlelés vagy USB) lehet séget. 
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11 Kattintson a NEXT gombra. Az alábbihoz hasonló Test Connection
(Kapcsolat tesztelése) lap jelenik meg.

12 Kövesse az utasításokat, majd kattintson a TEST (Tesztelés) gombra.

Tájékoztató üzenet jelenik meg arra vonatkozóan, hogy a kapcsolat 
sikeresen létrejött-e. Ha sikeres volt, menjen a következ  lépésre. 

MEGJEGYZÉS: A teszt
nem olvassa be a pumpa
adatait, hanem ellen rzi,

hogy megfelel -e
a kapcsolat a pumpa és

a számítógép között.

Ha nem volt sikeres, ellen rizze, hogy a készülék hardvere megfelel en 
csatlakozik-e a számítógéphez. Kattintson a BACK (Vissza) gombra 
a varázslóban, és ellen rizze, hogy helyesen adta-e meg a készülék 
adatait.

13 Kattintson a DONE (Kész) gombra.

Ezzel a pumpát hozzáadta a beteghez tartozó Active Devices listához.
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Mér eszköz hozzáadása            

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson duplán a beteg 
nevére a Patient Lookup táblázatban.

2 Gy z djön meg arról, hogy a hozzáadni kívánt mér eszköz kommunikál 
a számítógéppel. (A kapcsolódás lépéseir l itt olvashat: 5. fejezet: 
A hardver beállítása.)

3 Kattintson a DEVICES gombra a beteghez tartozó Devices munkaterület 
eléréséhez (a vonatkozó példa itt olvasható: 11. oldal).

4 Kattintson az ADD DEVICE gombra.

5 Válassza a Blood Glucose Meter (Vércukormér ) lehet séget.
Megjelenik az Add Blood Glucose Meter Wizard (Vércukormér
hozzáadása varázsló).

6 A választógomb segítségével jelölje ki a megfelel
mér eszközmárkát.

7 Kattintson a NEXT gombra. Megjelenik a Meter Model
(Mér eszközmodell) oldal (a mér eszköz gyártójától 
függ en az oldal tartalma változhat).
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8 Kattintással jelölje ki a hozzáadni kívánt mér eszközmodellt. 

9 Kattintson a NEXT gombra. Megjelenik a Communication Options
(Kommunikációs lehet ségek) oldal.

MEGJEGYZÉS: Csak
a hozzáadni kívánt

mér eszköz esetén
érvényes lehet ségeket

kínálja fel a rendszer.

10 A Choose Port legördül  menüb l válassza azt a portot, amelyre 

a ComLink, a Paradigm Link® vagy a CareLink USB kapcsolódik az 
Ön számítógépén. Ha nem biztos abban, hogy melyik port a megfelel ,
válassza az Auto Detect (Automatikus észlelés) lehet séget.

11 Kattintson a NEXT gombra. Megjelenik a Test Connection lap.

12 Kövesse az utasításokat, majd kattintson a TEST gombra.

Tájékoztató üzenet jelenik meg arra vonatkozóan, hogy a kapcsolat 
sikeresen létrejött-e. Ha sikeres volt, menjen a következ  lépésre. 

Ha nem volt sikeres, ellen rizze, hogy a készülék hardvere megfelel en 
csatlakozik-e a számítógéphez. Kattintson a BACK gombra a varázslóban, 
és ellen rizze, hogy helyesen adta-e meg az adatokat.

13 Kattintson a DONE gombra.

Ezzel a mér eszközt hozzáadta a beteghez tartozó Active Devices
listához.
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A készülék aktiválása és inaktiválása

A beteghez rendelt készülékeket szükség szerint lehet mozgatni az 
Active Devices és az Inactive Devices lista között. A készüléknek 
aktívnak kell lennie ahhoz, hogy adatokat lehessen beolvasni róla. 

Tetsz leges számú mér eszközt lehet felvenni az Active Devices
listára, de csak egyetlen pumpát lehet ott tárolni. Új pumpa hozzáadása 
el tt gy z djön meg arról, hogy inaktiválta a jelenleg aktív pumpát.

Készülék inaktiválása              

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson duplán a beteg 
nevére a Patient Lookup táblázatban.

2 Kattintson a DEVICES gombra a beteghez tartozó Devices munkaterület 
eléréséhez.

MEGJEGYZÉS:
A készülékek helyettesít

készülékek neve alatt is
megjelenhetnek. Lásd:

Helyettesít  készülékek,
5. oldal.

3 Kattintson a >> make this device inactive (készülék inaktiválása) 
lehet ségre az inaktiválni kívánt készülék alatt.

Ezzel az eszközt az Inactive Devices listára tette.

A készülék újbóli aktiválása               

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson duplán a beteg 
nevére a Patient Lookup táblázatban.

2 Kattintson a DEVICES gombra. A beteghez tartozó Devices
munkaterület jelenik meg.

3 Kattintson az >> activate this device (készülék aktiválása) 
lehet ségre az aktiválni kívánt készülék alatt.

Ezzel az eszközt az Active Devices listára tette.

A készülék törlése             

A következ  lépésekkel törli a készüléket és a benne lév  adatokat 
a Devices munkaterületr l és a CareLink Pro rendszerb l:

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson duplán a beteg 
nevére a Patient Lookup táblázatban.

2 Kattintson a DEVICES gombra a beteghez tartozó Devices
munkaterület eléréséhez.

3 Gy z djön meg arról, hogy az eszköz az Inactive Devices listán van. 
Ha nincs, kattintson az >> Inactivate this device (Készülék inaktiválása) 
lehet ségre az aktuális listán.
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4 Kattintson a >> delete this device (készülék törlése) lehet ségre 
a törölni kívánt készülék alatt.

Figyelmeztet  üzenet jelenik meg, mely arról tájékoztat, hogy 
a készülék és a benne tárolt adatok törl dnek a rendszerb l.

5 Törléshez kattintson a YES (Igen) gombra. 

A készülék és a benne tárolt adatok törl dnek a Devices
munkaterületr l és a CareLink Pro rendszerb l. A készülék 
adatait többé nem lehet jelentések készítésére használni.

A készülék adatainak beolvasása

Az adatok beolvasásának egyik módja a beteg meglév  CareLink 
Personal fiókjához való kapcsolódás. (További információt a következ
helyen talál: Kapcsolat létrehozása a CareLink Personal szoftverrel 
(választható), 26. oldal.) Másik lehet ség az e fejezetben leírt módon 
történ  közvetlen beolvasás a készülékr l.

A beteg készülékén tárolt adatokat akkor tudja beolvasni a CareLink Pro, 
ha a készülék az Active Devices listán van, és kommunikál a számítógéppel. 
Az adatok beolvasás után felhasználhatók jelentések készítésére és 
a beteg terápiás kezelésének kiértékelésére. (A jelentésekr l szóló 
részletek itt olvashatók: 7. fejezet: A Reports (Jelentések) munkaterület.)

Az alábbiakban néhány olyan információ látható, amelyet a CareLink Pro 
rendszer gy jt az inzulinpumpából egy feltöltés során:  

• a pumpa különféle beállításai, például a riasztás módja, a hangjelzés 
ereje és az id  kijelzése

• a beadott bázisinzulin mennyisége
• bólusesemények és beadott mennyiségek
• a Bolus Wizard bejegyzései
• a feltöltési mennyiségek
• a felfüggesztési id szakok
• a szenzor adott id szakban mért glükózadatai, a szenzorral ellátott 

pumpákon

A rendszerrel a Guardian REAL-Time rendszerr l is gy jthet k adatok, 
például az alábbiak:

• a szenzor által mért glükózértékek (SG)
• a szenzor koefficiens értékei
• a szenzor kalibrációs tényez i
• étkezésmarkerek
• inzulininjekciók
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Ezenkívül a vércukormér kben tárolt különféle információk is feltölthet k
a rendszerbe a készülékleolvasások során. 

VIGYÁZAT! Ehhez függessze fel vagy fejezze be az ideiglenes bázis vagy az aktív bolusok 
beadását, és törölje az aktív riasztásokat. A beolvasás idejére a pumpa m ködését felfüggeszti 
a rendszer. A beolvasás végén ellen rizze, hogy a pumpa újra m ködésbe lépett-e.

FIGYELEM! A pumpa adatainak beolvasása közben ne használja a távirányítót. 

Ha a pumpa elemének töltöttsége alacsony, a pumpa nem küld adatokat a számítógépnek. 
Cseréljen elemet, ha az állapotjelz  alacsony töltöttséget jelez.    

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson duplán a beteg 
nevére a Patient Lookup táblázatban.

2 Gy z djön meg arról, hogy a beteg készüléke kommunikál 
a számítógéppel. (További információt a következ  helyen talál: 
5. fejezet: A hardver beállítása.)

3 Kattintson a DEVICES gombra a beteghez tartozó Devices
munkaterület eléréséhez.

MEGJEGYZÉS:
A készülékek

helyettesít
készülékek neve alatt

is megjelenhetnek.
Lásd: Helyettesít

készülékek, 5. oldal.

4 Azonosítsa az Active Devices listában a készüléket, amelyr l adatokat 
szeretne lekérdezni, és gy z djön meg arról, hogy a Choose port
lehet ségnél megfelel  választ adott meg.
– Pumpa adatainak lekérdezéséhez az Amount of Data

(Adatmennyiség) legördül  menüb l válassza ki azt az 
adatmennyiséget, amelyet be kíván olvastatni a CareLink Pro 
rendszerrel.

5 Kattintson a READ DEVICE (Készülék beolvasása) gombra.

6 Kövesse az utasításokat, majd kattintson az OK gombra.

7 A CareLink Pro frissül  folyamatjelz vel mutatja, hogy a készülék 
beolvasása milyen mértékben teljesült.

8 Ha a készülék beolvasásakor a CANCEL (Mégse) gombra kattint, 
a megjelen  üzenet arra figyelmezteti, hogy a m velet visszavonása 
a beolvasott adatok elvesztésével jár. A feltöltés újraindításához 
a READ DEVICE gombra (5. lépés) kell kattintania.
– Visszavonáshoz kattintson a YES gombra. 
– Az adatok beolvasásának folytatásához kattintson a NO gombra.
Ha a rendszer befejezte a készülék adatainak beolvasását, 
megjelenik egy, a folyamat teljesülését meger sít  üzenet.

9 Kattintson az OK gombra. 

– Pumpánál kövesse az utasításokat a felfüggesztett mód 
megszüntetéséhez.

Ha a CareLink Pro nem tudja beolvasni a készülék adatait, további 
útmutatás itt található: 9. fejezet: Hibaelhárítás.
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A Reports (Jelentések) 
munkaterület 7
A fejezet tartalma
• Miel tt hozzákezdene…: 43. oldal
• Jelentések létrehozása: 44. oldal
• A jelentések ismertetése: 51. oldal
• Adatexportálás: 53. oldal

A CareLink™ Pro Reports munkaterület lehet vé teszi a készülékb l
nyert adatok klinikailag hasznos információvá történ  átalakítását. 
A létrehozható jelentéstípusokról itt olvashat: A jelentések ismertetése, 
51. oldal.

A jelentéseket a képerny n lehet létrehozni, közvetlenül nyomtatóra 
lehet küldeni, valamint TIFF vagy PDF formátumban lehet menteni és 
elektronikus kórlaphoz (Electronic Medical Record) csatolni. Egyetlen 
m velettel számos jelentéstípust hozhat létre.

A jelentésekben foglalt adatokat a beteg készülékér l vagy CareLink 
Personal-fiókjáról (esetleg mindkett r l) lehet letölteni. 

Miel tt hozzákezdene…

Ahhoz, hogy a jelentésbe bele tudjon foglalni egy adott id szakot, 
rendelkeznie kell a beteg készülékének adataival arra az id szakra. 
Jelentéskészítés el tt szükséges lehet az is, hogy a beteg készüléke 
csatlakozzon a számítógéphez, hogy az aktuális adatok lekérdezhet k
legyenek.
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Jelentéskészítés el tt gy z djön meg arról, hogy alaposan áttanulmányozta 
a Verify Report Settings (Jelentés beállításainak ellen rzése) lépést. Itt 
tudja beállítani a jelentés részleteit ahhoz, hogy a kívánt betegadatokat 
tudja letölteni.

Jelentések létrehozása

A következ  részek a jelentéskészítés lépéseit írják le.

A Reports munkaterület megnyitása      

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson az OPEN PATIENT 
(Beteg adatainak megnyitása) gombra, és kattintson duplán a beteg nevére.

Ekkor megjelenik a Reports munkaterület (lásd a példát itt: 11. oldal).

MEGJEGYZÉS: Ahhoz,
hogy biztosan
a legfrissebb

készülékadatokkal
rendelkezzen a beteg

CareLink Personal-
fiókjából, kattintson

a SYNC DATA
(Adatszinkronizálás)

gombra.

A jelentés id szakának kiválasztása        

1 A jelentés(ek) id szakának módosításához a Duration (Id tartam)
legördül  menüb l válassza ki a kívánt id tartamot. (A leghosszabb 
id tartam 12 hét.)

2 Az id szak kezd  és záró dátumát automatikusan beállítja a rendszer, 
de a felhasználó módosíthatja ezt a custom date range (egyéni 
dátumtartomány) beállítással. 

MEGJEGYZÉS:
A megengedettnél
hosszabb id szak

kiválasztásakor
a rendszer hibaüzenetet

küld. Módosítsa az
id tartamot vagy

a dátumokat.

Ha a dátumtartomány egyéni beállítását választja, kattintson a From
(Kezd  dátum) és a Through (Záró dátum) legördül  listára a kívánt 
hónap, nap vagy év kiválasztásához. 

Adatnaptár

A Reports munkaterület adatnaptár-területe háromhónapos id szakokra 
bontva mutatja meg a jelentésbe foglalható adatokat. Itt láthatók 
a készülékek és a kiválasztott háromhónapos id szakban rögzített 
készülékadatok mennyisége. Szintén itt látható a kiválasztott három 
hónapos id tartamon belül kijelölt jelentési id szak is. 

Az Open Patient (Beteg
adatainak megnyitása)

gomb

készülékadatok
jelentési id szak

adatnaptár
hónapok
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A készülékadatok és a jelentési id szak közötti átfedés azt jelenti, 
hogy az adatok rendelkezésre állnak a kiválasztott jelentési id szak 
egy részére vagy egészére.

Az adatnaptár-területen els ként az elmúlt három hónap adatai 
láthatók. A többi hónap adatainak megtekintéséhez kattintson 
a hónapsáv elején vagy végén lév  nyílra.

A jelentésbe foglalandó forrásadatok kiválasztása       

1 Ha a beteg olyan vércukorszintmér t használ, amely csatlakozik 
a pumpájához, a mér eszköz VC-értékeinek jelentésbe foglalásához 
kattintson a következ  lehet ségek egyikére: 

– in the pump (pumpa adatai): E választás el nye, hogy elegend
a beteg pumpájának adatait beolvasni, mert a VC-értékeket a pumpa 
id bélyeggel látja el, és az értékek közvetlenül a Bolus Wizard 
számításaihoz kapcsolódnak. Hátránya, hogy ha kommunikációs 
nehézségek vannak a pumpa és a csatlakozó mér eszköz között, 
az adott id szak VC értékei-nem fognak szerepelni a jelentésben. 
Hasonlóképpen az 522/722-es típusnál korábbi MiniMed Paradigm 
pumpáknál a Bolus Wizard számításai által nem érintett VC-értékek 
szintén nem kerülnek be a jelentésbe.

– in the link meter(s) (mér eszköz adatai): E választás el nye, hogy 
a csatlakozó mér eszközben tárolt összes érték bekerül a jelentésbe. 
Hátránya, hogy a mér eszköz és a pumpa adatainak korrelációjához 
el zetesen szinkronizálni kell a pumpa és a mér eszköz id mér jét. 
A pumpa és a csatlakozó mér eszköz adatait külön-külön kell 
beolvasni.

2 A készülék adatainak jelentésbe foglalásához jelölje ki a megfelel
készülék mellett lév  négyzetet. 

Az 1. lépésben hozott választás eredményeként kizárt készülékek 
adatai nem adhatók a jelentéshez. Ennek megváltoztatásához 
válassza a másik (mér eszköz) lehet séget.

a készülékadatok és a jelentési 
id szak közötti átfedés

Nyílgombok
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3 A készülék adatainak jelentésb l történ  kizárásához szüntesse meg 
a megfelel  készülék mellett lév  négyzet kijelölését. 

Az 1. lépésben hozott választás függvényében bizonyos kijelöléseket 
nem szüntethet meg. Ennek megváltoztatásához válassza a másik 
(mér eszköz) lehet séget.

A készülékadatok ellen rzése       

1 Tekintse meg a Reports munkaterület adatnaptár-területét, és 
ellen rizze, hogy a jelentési id szak átfedi-e a készülékadatokat 
(a példát lásd itt: 45. oldal).

2 Ha a sávok átfedik egymást a teljes jelentési id szakban, a jelentéshez 
szükséges adatok rendelkezésre állnak. Kattintson a NEXT (Tovább) 
gombra, és folytassa a következ vel: Jelentés beállításainak 
ellen rzése, 48. oldal.

3 Ha a sávok nem vagy csak kis mértékben fedik át egymást, 
a következ ket teheti:
– A jelentési id szak beállítása (lásd: A jelentés id szakának

kiválasztása, 44. oldal).
– További készülékadatok beolvasása (lásd: További 

készülékadatok beolvasása, 46. oldal).

További készülékadatok beolvasása         

1 További adatok beolvasásához kattintson a READ DEVICE 
(Készülék beolvasása) gombra.

Megjelenik a Read Device sáv.

VIGYÁZAT! Ehhez függessze fel vagy fejezze be az ideiglenes bázis vagy az aktív bolusok 
beadását, és törölje az aktív riasztásokat. A beolvasás idejére a pumpa m ködését felfüggeszti 
a rendszer. A beolvasás végén ellen rizze, hogy a pumpa újra m ködésbe lépett-e.

FIGYELEM! A pumpa adatainak beolvasása közben ne használja a távirányítót. 

Ha a pumpa elemének töltöttsége alacsony, a pumpa nem küld adatokat a számítógépnek. 
Cseréljen elemet, ha a készülék állapotjelz je alacsony töltöttséget jelez.    

READ DEVICE sáv

READ DEVICE gomb
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2 Ellen rizze, hogy a Choose port (Port kiválasztása) lehet ségnél 
megfelel  választ adott-e meg. 

A beállítás megváltoztatásához kattintson a mez höz tartozó 
legördül  listára, és válasszon másik beállítást.

3 Ellen rizze, hogy a készülék a számítógéphez van-e csatlakoztatva. 

4 Ha a készülék pumpa, megadhatja a lekérni kívánt adatmennyiséget. 
Kattintson az Amount of Data (Adatmennyiség) legördül  listára, és 
válasszon értéket.

MEGJEGYZÉS: Ha az All
available data (Minden

rendelkezésre álló adat)
lehet séget választja,
a rendszer az összes

rendelkezésre álló
adatot beolvassa

a pumpából. Ezzel
felülírja a rendszerben

duplán meglév
adatokat.

5 Kattintson a READ DEVICE gombra. Gondosan olvassa el a megjelen
üzenetet, mert abban fontos tudnivalókat talál a pumpa adatainak 
beolvasásáról.

6 Kövesse az utasításokat, majd kattintson az OK gombra. 

Megjelenik a készülék beolvasását jelz  folyamatsáv.

A beolvasást bármikor leállíthatja, ha a CANCEL (Mégse) 
gombra kattint.

A beolvasás végét meger sít  üzenet jelenik meg.

7 Kattintson az OK gombra.

Ekkor megjelennek a készülékadatok az adatnaptáron belül.

8 Kattintson a Reports munkaterület tetején található NEXT gombra.

Ekkor megjelenik a Verify Report Settings lépés. Itt ellen rizheti 
jelentéskészítés el tt, hogy a betegre érvényes beállítások megfelel k-e.

id tengely

étkezési id szak

étkezések id szakának bevitelére 
szolgáló mez k

lefekvési és felkelési id szak
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Jelentés beállításainak ellen rzése           

1 Ellen rizze, hogy megfelel k-e a Glucose Target (Vércukor célértéke) 
beállításai. Írja be a megfelel  értékeket, vagy kattintson a fel vagy le 
nyílra a Low (Alsó) vagy a High (Fels ) mez ben az értékek növeléséhez 
vagy csökkentéséhez.

MEGJEGYZÉS:
Összesen öt étkezési

id szakot választhat. Az
alapértelmezettek

a reggeli, ebéd
és vacsora.

2 Új étkezési id szak hozzáadásához kattintson az ADD MEAL (Étkezés 
hozzáadása) gombra. Létez  étkezési id szak szerkesztéséhez 
kattintson bárhova az id tengely mentén az étkezési id szak területén.

Ekkor az id tengely alatt található Meal Period (Étkezési id szak) 
szerkeszt  aktívvá válik.

3 Írja be az adatokat, vagy a nyilak segítségével adja meg a kívánt 
beállításokat.

MEGJEGYZÉS: Ha
a beállításokat csak erre

az étkezésre kívánja
alkalmazni, törölje a Use

these parameters for all
of this patient’s meals

(Ezen paraméterek
alkalmazása a beteg

összes étkezésére)
jelöl négyzet jelölését.

– Meal Name (Étkezés megnevezése): Az étkezési id szaknak
adni kívánt név.

– Meal Time Period (Étkezés ideje): Az étkezési id  kezdetét és 
végét jelz  órák.

– Pre-Meal BG Target (mg/dL vagy mmol/L) (Étkezés el tti
VC-célérték, mg/dl vagy mmol/l): A beteg étkezés el tti 
vércukor-céltartományának alsó és fels  határa.

– Pre-Meal Analysis Period (Étkezés el tti elemzés ideje):
Megadja, hogy az étkezés el tt mennyi id vel kerüljön sor 
vércukorelemzésre. Az ebben az id szakban rögzített 
vércukorszint-értékek a részletes jelentéselemzésbe kerülnek.

– Post-Meal BG Target (mg/dL vagy mmol/L) (Étkezés utáni 
VC-célérték, mg/dl vagy mmol/l): A beteg étkezés utáni 
vércukor-céltartományának alsó és fels  határa.

– Post-Meal Analysis Period (Étkezés utáni elemzés ideje):
Megadja, hogy az étkezés után mennyi id vel kerüljön sor 
vércukorelemzésre. Az ebben az id szakban rögzített 
vércukorszint-értékek a részletes jelentéselemzésbe kerülnek.

MEGJEGYZÉS: Az
étkezési id szakok

között nem lehet átfedés,
de kezd  és záró
id pontjuk révén

határaik egybeeshetnek.
Az étkezési

id szakoknak legalább
60 perceseknek kell

lenniük.

Az étkezési id szakok hosszát vagy a felkelés és a lefekvés idejét 
a sávok elején vagy végén lév  fogantyúkra kattintva, azokat az 
id tengely mentén a kívánt helyre húzva változtathatja meg. 
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4 Ha ezeket a beállításokat kívánja alkalmazni a beteg összes étkezésére, 
jelölje be a Use these parameters for all of this patient’s meals
jelöl négyzetet.

5 Az étkezési id szak létrehozásának vagy szerkesztésének végén 
kattintson a SAVE (Mentés) gombra.

6 Étkezési id szak eltávolításához kattintson a DELETE MEAL (Étkezés 
törlése) gombra. Ha a rendszer meger sítést kér, kattintson 
a DELETE gombra.

7 A CareLink Pro képes tárolni a beállításokat ehhez a beteghez a következ
jelentéskészítéshez. Ehhez kattintson a SAVE SETTINGS (Beállítások 
mentése) gombra.

8 Kattintson a Reports munkaterület tetején található NEXT gombra. 

Ekkor megjelenik a folyamat Select and Generate Reports (Jelentések 
kiválasztása és létrehozása) lépése. A képerny n a jelentéstípusok 
listája és egy adattábla látható, melyek segítségével kiválaszthatja, 
mely napok adatait veszi fel és melyeket hagyja ki a részletes napi
jelentésekb l.

9 A képerny n látható tartalom kinyomtatásához kattintson 
a nyomtatóikonra.

kattintson a fogantyúra, majd húzza a kívánt helyre az id tengelyen

id tengely

mért értékek jelei
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MEGJEGYZÉS:
Az adattábla

megjelenésének
módosításához kattintson
a >> customize columns
(oszlopok testreszabása)

elemre. Lásd:
A jelentéskészítéssel

kapcsolatos beállítások,
22. oldal.

Jelentéstípusok és felvenni kívánt dátumok kiválasztása          

1 Jelölje ki a jelentéslistába foglalni kívánt jelentés(ek) mellett lév
négyzeteket.

2 Ha az adott jelentési id szakban többször is beolvasták a pumpa vagy 
a Guardian monitor adatait, több pillanatkép is létezhet a készülékr l:

a. Gy z djön meg arról, hogy a Device Settings Snapshot
(Készülékbeállítások pillanatképe) jelöl négyzet be van jelölve. 

b. Kattintson a legördül  nyílra, majd válassza ki a pillanatkép 
dátumát és idejét. 

– Pump: Válasszon pillanatképet a beteg pumpájából.
– Guardian: Válasszon pillanatképet a beteg Guardian monitorából. 

Ha a mez k bármelyike szürke, akkor nem áll rendelkezésre pillanatkép 
a jelentési id szakra.

3 Görgesse végig az adattáblát, és tekintse át a rendelkezésre álló 
részletes napi jelentéseket. 

– Mindegyik oszlopban rendezheti az adatokat. Az oszlop fejlécére 
kattintva növekv  sorba rendezheti az adatokat. Ismét az oszlop 
fejlécére kattintva csökken  sorba rendezheti az adatokat.

MEGJEGYZÉS: Nem
lehet kiválasztani egy

bizonyos napot, ha
nincs adat arra a napra.

4 Jelölje be az adattáblasorok jelöl négyzeteit azon dátumok mellett, 
amelyekre Daily Detail jelentést kér. 

– Az összes részletes napi jelentést felveheti vagy kihagyhatja 
egyetlen kattintással, ha az adattábla tetején a jelöl négyzetek 
oszlopa fölötti jelöl négyzetre kattint.

adattábla

nyomtatóikon
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Jelentések készítése                                  

1 A jelentések kiválasztásának ellen rzése után kattintson a GENERATE 
REPORTS (Jelentések létrehozása) gombra a Reports munkaterület 
tetején.

Megjelenik a lehet ségek listája.

2 Válassza a jelentés(ek) megtekintésének, nyomtatásának vagy 
mentésének lehet ségét.

Ha a Preview (Megtekintés) lehet séget választotta, a Report Preview
(Jelentés el nézete) ablak jelenik meg.

3 A nyilakra kattintva végigböngészheti a többoldalas jelentéseket.

4 Kattintson a Report Preview ablak tetején lév  gombok egyikére 
a jelentés(ek) mentéséhez vagy nyomtatásához.

5 Az ablak bezárásához kattintson az ablak jobb fels  sarkában található 
CLOSE gombra.

A jelentések ismertetése         

Az alábbiakban az egyes jelentések leírását olvashatja. A jelentések 
elemeir l további részleteket és jelentésmintákat a jelentések 
útmutatójában talál. A jelentések útmutatóját a CareLink Pro 
alkalmazásból érheti el:

1 Help > View Report Reference Guide (PDF) (Súgó > A jelentések 
PDF formátumú útmutatójának megtekintése). 

2 Válasszon nyelvet a jelentések útmutatójának megtekintéséhez.

A CareLink Pro jelentéseinek közös jellemz i:

• Jelentés fejléce – A jelentés fejléce azonosító adatokat tartalmaz, 
például a jelentés nevét, a beteg nevét és az adatok forrását.

• Szénhidrátok és vércukorszint – A grafikonokon és diagramokon 
a szénhidrátegységek d lten, a vércukorszintegységek félkövéren 
jelennek meg.

• Hétvége adatai – A hétvége napjai félkövéren jelennek meg 
a könnyebb azonosítás érdekében.

Az el nézetet bezáró
CLOSE gomb
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• Jelmagyarázat – A jelentések végén jelmagyarázat látható. 
A szimbólumok több jelentésben is el fordulhatnak, de a jelentések 
jelmagyarázatai egyediek.

Adherence Report (Együttm ködési jelentés)        

Ez a jelentés az inzulinpumpák és szenzorok használatát leíró adatokat 
szolgáltat, és megmutatja a beteg viselkedését a terápiával szemben. 
A következ  kérdésekre ad választ: Van-e elegend  adat annak pontos 
megítélésére, hogy a beteg miként használja inzulinpumpáját és szenzorát, 
ha kapott ilyet? Betartja-e a beteg a terápiás utasításokat? Azt is 
megmutatja, hogy szükséges-e beszélnie a beteggel arról, hogy miként 
viszonyul cukorbetegségéhez.

Sensor and Meter Overview Report (A szenzor- és mér adatok 
összefoglaló jelentése)        

A szenzor- és mér adatok összefoglaló jelentése grafikus képet ad 
a beteg mért vércukorszintjér l és az átlagértékekr l, a nap 24 órájáról 
óránkénti bontásban, valamint arról, hogy ezek miként viszonyulnak 
a beteg étkezési és alvási szokásaihoz. A jelentés a beteg vércukorszintjét 
és inzulinhasználatát tükröz  statisztikát is tartalmaz. 

Ha vannak szenzoradatok, akkor a rendszer azokról hasonló elemzést 
készít, mint ennek a jelentésnek az els  oldala. Ha nincsenek szenzoradatok, 
a jelentés els  oldalán a mér eszköz adatainak elemzése látható.

A jelentés utolsó oldalai a beteg napi glikémiás, szénhidrát- és 
inzulinkontrolljának szintjét és min ségét mutatják. Az oldalanként 
legfeljebb 14 nap adatát mutató lapok jelzik, miként változik naponta 
ez a kontroll a jelentési id szakban.

Logbook Report (Naplójelentés)        

A naplójelentés a jelentési id szak napjain a mér eszköz által mért 
vércukor-, szénhidrát- és inzulinadatokat mutatja. Az óránként rögzített 
eseménynapló mellett tartalmazza a napi adatok átlagát és összegzését 
is. Mindegyik oldal legfeljebb 14 nap adatát tartalmazza. Ha a jelentési 
id szak hosszabb 14 napnál, a rendszer további oldalakat ad a jelentéshez.

Device Settings Snapshot (A készülékbeállítások pillanatképe)        

Ez a jelentés a pumpa vagy a Guardian REAL-Time monitor adott dátumra 
és id pontra érvényes beállításainak pillanatképét tartalmazza. Ennek
segítségével értelmezheti a többi jelentést, vagy csak dokumentálhatja 
a betegre érvényes beállításokat. 
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A pumpa vagy a monitor beállításait csak a készülékek beolvasásakor 
lehet rögzíteni. Ha a készülék adatait nem olvasták be a jelentési 
id szakban, a beállítások nem állnak rendelkezésre.

Daily Detail Report (Részletes napi jelentés)        

A részletes napi jelentés megmutatja a beteg vércukorszintjét, 
szénhidrátmennyiségeit és inzulinfogyasztását a kiválasztott napra. 
Az adattáblán kiválasztott mindegyik napról külön jelentés készül.

A részletes napi jelentés megmutatja a kiválasztott nap összes részletét. 
Segítségével egy adott napra összpontosíthat, ha úgy érzi, hogy azon 
a napon a beteg terápiája szempontjából fontos esemény történt.

Adatexportálás

A CareLink Pro által beolvasott és tárolt készülékadatokat exportálhatja. 
Ennek segítségével statisztikai célokra vagy speciális jelentések és 
diagramok készítéséhez gy jtheti össze a beteg összes készülékadatát. 
A .csv fájl importálható a Microsoft Excel alkalmazásba vagy egyes 
klinikai statisztikai programokba a további adatkezeléshez.

A .csv fájl a készülék m veleteit rögzít  adatokat tartalmaz. Például 
megjeleníti a mért értékek rögzítését, a mér eszközzel mért érték 
pumpa általi fogadását vagy a bázisinzulin változását.

MEGJEGYZÉS: Ez olyan
speciális szolgáltatás,

amelyhez szükséges
a készülék saját

adatformátumának
ismerete. Ismerni kell

azt a szoftvert is,
amelybe a .csv fájlt

importálja.

A CareLink Pro exportálási szolgáltatását a következ  lépésekkel 
veheti igénybe:

1 Kattintson a beteg adatait jelz  fülre, vagy kattintson az OPEN 
PATIENT gombra, és kattintson duplán a beteg nevére.

2 Ellen rizze, hogy megjelenik-e a Reports munkaterület.

3 A Duration (Id tartam) vagy a From/Through (Kezd  dátum/Záró 
dátum) mez kkel állítsa be a dátumokat és a jelentés hosszát.

A leghosszabb választható id tartam 12 hét.
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4 Kattintson az export selected data (kiválasztott adatok exportálása) 
hivatkozásra.

Ekkor megjelenik az Export Data to CSV File (Adatok exportálása 
CSV-fájlba) párbeszédpanel.

5 Ha a .csv fájl tárolási helyét meg szeretné változtatni a számítógépen, 
kattintson a Save in (Mentés helye) mez  jobb oldalán lév  nyílra, és 
válasszon másik helyet.

6 Ha módosítani szeretné a fájl nevét, írja be a kívánt nevet a File name
(Fájlnév) mez be.

7 Kattintson a SAVE (Mentés) gombra.

MEGJEGYZÉS:
A CSV-fájlban

megjelen  adatokról
további információt
a következ  helyen

talál: CSV-adatok,
66. oldal.

Ezzel mentette a .csv fájlt a számítógépen a kiválasztott helyre. Ezek 
után a fájltípust támogató bármelyik programba importálhatja azt.

export selected data 
hivatkozás
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Rendszerfelügyelet 8
A fejezet tartalma
• Miel tt hozzákezdene…: 55. oldal
• A szoftverfrissítések telepítése: 56. oldal
• Adatbázis biztonsági mentése és helyreállítása: 57. oldal

Fontos, hogy rendszeresen készítsen biztonsági másolatot 

a CareLink™ Pro-adatbázisról. Az adatbázis a beteg rekordjaiban 
összegy lt összes rendszeradatot tárolja, így a profiladatokat, 
a készülékb l nyert adatokat és a jelentésbeállításokat is. 

A CareLink Pro lehet vé teszi az adatbázisról készült másolatok 
mentését és visszaállítását.

Fontos az is, hogy a CareLink Pro legújabb verziójával rendelkezzen. 
Rendszeres id közönként jelennek meg frissített verziók, amelyek fontos 
újításokat tartalmazhatnak. Választhat, hogy Ön kívánja ellen rizni, hogy 
vannak-e új frissítések, vagy értesítést szeretne kapni azok megjelenésér l.

Miel tt hozzákezdene…

Célszer  egy szabályos id közönkénti ütemezést beállítani az adatbázis 
biztonsági mentésének végrehajtásához. Ezzel biztosítható a rendszeresség, 
és minimalizálható az adatvesztés kockázata. 

Biztonsági mentés vagy visszaállítás során a CareLink Pro észleli 
a szoftvert más számítógépeken használó felhasználókat, és 
lehet séget kínál számukra a munkájuk mentésére. Az eljárások 
bármelyikének megkezdése el tt ugyanakkor ajánlott meggy z dni 
arról, hogy más felhasználók nem használják éppen a szoftvert.
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A szoftverfrissítések telepítése         

Frissítések automatikus keresése

A CareLink Pro szoftverhez alkalomszer en jelennek meg frissítések. 
Ha megjelenik egy frissítésr l tájékoztató értesítés, a legújabb 
szoftverkiadás letöltéséhez hajtsa végre az alábbi lépéseket.

MEGJEGYZÉS:
A szoftverfrissítések

telepítése el tt az
adatbázisról biztonsági

másolatot kell készíteni.
Lásd: Adatbázis

biztonsági mentése,
57. oldal.

1 Gy z djön meg arról, hogy a számítógép kapcsolódik az internetre.

2 Ha van elérhet  frissítés a CareLink Pro szoftverhez, megjelenik 
a CareLink Pro Update (CareLink Pro-frissítés) üzenet. Az üzenet 
felajánlja a frissítés letöltésére szolgáló lehet séget.

3 Kattintson a DOWNLOAD (Letöltés) gombra. (Ha a CANCEL (Mégse) 
gombra kattint, a frissítési üzenet bezáródik. Ez esetben a frissítést 
egy kés bbi id pontban is letöltheti.)

Megjelenik egy, az adatbázis biztonsági mentését felajánló figyelmeztet
üzenet.

4 A biztonsági másolat létrehozásához kattintson a YES (Igen) gombra 
(err l az eljárásról lásd: Adatbázis biztonsági mentése, 57. oldal).
Ha nem kíván biztonsági másolatot készíteni az adatokról, kattintson 
a NO (Nem) gombra.

A CareLink Pro új verziójának letöltését egy üzenet megjelenése jelzi.

5 Ha meg kívánja kezdeni a CareLink Pro legújabb verziójának 
használatát, a szoftveralkalmazás bezárásához, majd újbóli 
megnyitásához kattintson a YES gombra. Kattintson a NO gombra, 
ha a CareLink Pro használatát nem kívánja azonnal megkezdeni.

Az automatikus frissítések kikapcsolása

Ha nem szeretné megkapni a CareLink Pro frissítéseir l szóló 
automatikus értesítéseket, kövesse az alábbi lépéseket:

1 Válassza a Tools > Options (Eszközök > Beállítások) parancsot.

2 Kattintson a General (Általános) fülre.

3 A Communications (Kommunikáció) csoportban törölje az Automatically
check for software updates (Szoftverfrissítések automatikus keresése) 
jelöl négyzet jelölését.
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Frissítések manuális keresése

Manuálisan bármikor ellen rizheti, hogy vannak-e elérhet  frissítések 
a CareLink Pro szoftverhez.

MEGJEGYZÉS:
A szoftverfrissítések

telepítése el tt az
adatbázisról biztonsági

másolatot kell készíteni.
Lásd: Adatbázis

biztonsági mentése,
57. oldal.

1 Gy z djön meg arról, hogy a számítógép kapcsolódik az internetre.

2 Válassza a Tools > Check for Software Updates (Szoftverfrissítések 
keresése) lehet séget.

3 Ha nincs elérhet  frissítés, a program megjelenít err l egy üzenetet. 
Ha van elérhet  frissítés, megjelenik a CareLink Pro Update üzenet. 

4 Kövesse a következ  részben leírt eljárást: Frissítések automatikus 
keresése, 56. oldal.

Adatbázis biztonsági mentése és helyreállítása

Adatbázis biztonsági mentése     

Az alábbi lépésekkel a kívánt helyen elkészítheti az aktuális adatbázis 
biztonsági másolatát.

1 Gy z djön meg arról, hogy az összes rekord be van zárva.

2 Válassza a Tools > Backup Database (Adatbázis biztonsági 
mentése) parancsot.

MEGJEGYZÉS: Az
adatbázis biztonsági

másolata hálózati
meghajtóra

vagy cserélhet
tárolóeszközökre

(DVD-re, CD-re,
USB-meghajtóra stb.)

egyaránt menthet .

3 Ha a biztonsági másolatot egy másik helyre kívánja menteni 
a számítógépen, kattintson a Save in (Mentés helye) mez  jobb 
oldalán lév  nyílra, és válasszon egy másik helyet.

4 Ha módosítani szeretné a biztonsági másolat fájljának nevét, írja be 
a kívánt nevet a File name (Fájlnév) mez be.

5 Kattintson a SAVE (Mentés) gombra. Az adatbázis mentése során egy 
folyamatsáv látható.

A biztonsági mentés befejez désér l egy üzenet tájékoztatja.

6 Kattintson az OK gombra az üzenet bezárásához.
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Adatbázis visszaállítása         

El fordulhat, hogy az aktuális adatbázist le kell cserélni, ha az már 
nem érhet  el vagy nem használható.

FIGYELEM! A biztonsági másolattal történ  visszaállítás esetén a kiválasztott biztonsági 
másolat készítése óta létrehozott minden adat elvész.

Az alábbi lépésekkel kiválaszthatja azt a biztonsági másolatot, amellyel 
le kívánja cserélni az aktuális adatbázist.

1 Gy z djön meg arról, hogy az összes rekord be van zárva.

2 Válassza a Tools > Restore Database (Adatbázis visszaállítása) 
parancsot. 

3 Jelölje ki azt a biztonságimásolat-fájlt, amelyet az aktuális adatbázis 
lecseréléséhez használni kíván (ez általában a legújabb fájl).

4 Kattintson az OPEN (Megnyitás) gombra. Ekkor megjelenik egy 
figyelmeztet  üzenet. Kattintson az OK gombra.

5 Az adatbázis visszaállítása során egy folyamatsáv látható.

Az adatbázis-visszaállítási m velet befejez désér l egy üzenet 
tájékoztatja.

6 Kattintson az OK gombra az üzenet bezárásához.

Teend k a rendszer elérhetetlensége esetén                

Ha úgy próbálja elindítani a rendszert, hogy közben egy másik felhasználó 
biztonsági mentést vagy visszaállítást végez, megjelenik egy arról 
tájékoztató üzenet, hogy a rendszer nem érhet  el. A feladat 
befejez déséig nem érheti el a rendszert.

A következ  lehet ségek közül választhat:

• Várjon, amíg a folyamat befejez dik, és a rendszer elérhet vé válik.
• Kattintson a CANCEL gombra a kilépéshez, és próbálkozzon újra kés bb.
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Hibaelhárítás 9
A fejezet tartalma
• Általános alkalmazáshasználati hibák: 59. oldal
• Készülékleolvasási hibák: 61. oldal
• Jelentés-létrehozási hibák: 62. oldal
• Biztonsági mentéssel és visszaállítással kapcsolatos hibák: 63. oldal
• A szoftver eltávolítása: 63. oldal

Ez a fejezet segítséget nyújt a CareLink™ Pro szoftver használata 
során esetleg el forduló hibák megoldásához, valamint a CareLink Pro 
szoftver esetleg szükségessé váló eltávolításának lépéseit is tartalmazza.

Általános alkalmazáshasználati hibák

A szoftverfrissítések interneten keresztüli letöltéséhez szükséges 
jogosultságok

Ha megkísérel letölteni egy szoftverfrissítést az interneten keresztül, 
el fordulhat, hogy tájékoztató üzenet jelenik meg arról, hogy nincs 
ehhez elegend  jogosultsága. A CareLink Pro frissítéseinek letöltéséhez 
rendszergazdai jogosultságokkal kell rendelkeznie.

1 Zárja be a CareLink Pro szoftveralkalmazást, és indítsa újra 
a számítógépet. 

2 Kérjen meg egy rendszergazdai jogosultságokkal rendelkez
felhasználót, hogy jelentkezzen be a számítógépre.

3 Kövesse a következ  részben található utasításokat: 
A szoftverfrissítések telepítése, 56. oldal.
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Nincs kapcsolat az adatbázissal

Egy, az adatbázissal való kapcsolat megszakadását jelz  hibaüzenet 
az alábbiak egyikér l tájékoztat:

• The database has been moved. The database must be located in the 
same place that was selected during installation of the CareLink Pro 
software. If it has been moved, it must be moved back to the location 
selected during installation. (Az adatbázist áthelyezték. Az adatbázisnak 
a CareLink Pro szoftver telepítése során megadott helyen kell lennie. 
Ha azt id közben áthelyezték, vissza kell helyezni a telepítés során 
kiválasztott helyre.)

• You are not connected to the network drive where the database is 
located. If the database is located on a network drive, the network may 
occasionally experience problems that prevent you from accessing the 
drive. Contact your computer support department for help in reconnecting 
to the network drive where the database is located. (Nem kapcsolódik 
az adatbázisnak helyet adó hálózati meghajtóhoz. Ha az adatbázis egy 
hálózati meghajtón található, el fordulhat, hogy id nként problémák 
lépnek fel a hálózattal kapcsolatban, melyek megakadályozzák 
a meghajtó elérését. Az adatbázist tartalmazó hálózati meghajtóhoz 
való ismételt csatlakozáshoz kérje az informatikai támogatási részleg 
segítségét.) 

Elfelejtette a rendel  CareLink Pro szoftverhez használt jelszavát

Ha senki sem emlékszik a rendel  által a CareLink Pro szoftverbe való 
bejelentkezéshez használt jelszóra, újra kell telepíteni a CareLink Pro 
szoftvert, és létre kell hozni egy új adatbázist. A szoftver újratelepítését 
követ en nem érhet k el a korábbi adatbázisban található betegadatok. 
Az új telepítés során létrehozott jelszót helyezze biztonságos helyre 
valahol az irodában, így a jöv ben nem veszíti el az adatokat. 
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Készülékleolvasási hibák

Készülékleolvasási hiba Jelentés

The selected serial port could 
not be opened. Another 
operation might be in progress 
on that port. Please wait until 
the port is available, or select 
another port. (A kiválasztott 
soros portot nem lehetett 
megnyitni. El fordulhat, hogy 
egy másik m velet folyamatban 
van a porton. Várjon, amíg 
a port elérhet vé válik, vagy 
válasszon egy másik portot.)

Gy z djön meg arról, hogy a kiválasztott kommunikációs 
portot nem használja egy másik program, vagy 
válasszon egy másik portot. Próbálkozzon 
a számítógép újraindításával, majd a készülék 
ismételt leolvasásával. El fordulhat, hogy a porthoz 
csatlakoztatott hardvereszköz (kábel stb.) vagy maga 
a port meghibásodott. A probléma meghatározásához 
csatlakoztassa a hardvereszközt egy másik porthoz, 
és kísérelje meg újra a készülék leolvasását. 

Auto Detect could not find the 
device on any available port. 
Please check the cable 
connection, device battery 
& status and try again, or 
try specifying a serial port. 
(Az automatikus észlelési 
szolgáltatás egyik elérhet
porton sem észlelte 
a készüléket. Ellen rizze
a kábelkapcsolatot, valamint 
a készülék telepét és állapotát, 
majd próbálkozzon újra, vagy 
adjon meg egy soros portot.)

Ellen rizze a kábel és a számítógép közötti 
kapcsolatot, és gy z djön meg arról, hogy a készülék 
telepének töltöttsége megfelel . Ha igen, az 
automatikus észlelés választása helyett adja meg 
a számítógép azon soros portját, amelyhez a kábel 
csatlakozik.

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try again, 
try selecting a different port, or 
try to Auto Detect the device. 
(Az eszköz nem található 
a kiválasztott soros porton. 
Ellen rizze a kábelkapcsolatot, 
valamint a készülék telepét és 
állapotát. Ezután próbálkozzon 
újra, válasszon egy másik 
portot, vagy próbálja 
automatikus észleléssel 
megkeresni a készüléket.)

Ellen rizze a kábel és a számítógép közötti 
kapcsolatot, és gy z djön meg arról, hogy a készülék 
telepének töltöttsége megfelel . Ha igen, válasszon 
egy másik soros portot a számítógépen, vagy 
válassza az automatikus észlelést.

Unable to communicate with 
the device. Please ensure 
you’ve attached and selected 
the correct device, check the 
cable connection, device 
battery and status, and try 
again. (Nem lehet kommunikálni 
a készülékkel. Gy z djön meg 
arról, hogy a megfelel
készülék van csatlakoztatva, 
illetve kiválasztva, ellen rizze
a kábelkapcsolatot, valamint 
a készülék telepét és állapotát, 
majd próbálkozzon újra.)

Ellen rizze a készülékleolvasáshoz kiválasztott 
beállításokat, köztük a készülék nevét, a sorozatszámot 
és a kapcsolat típusát. Gy z djön meg arról is, hogy 
a készülék, a kábel és a számítógép megfelel en
csatlakozik egymáshoz. Ellen rizze, hogy megfelel -e 
a készülék teleptöltöttsége és riasztási állapota. 
Kísérelje meg újra a leolvasást.

Unexpected response… 
retrying (n%) 
(Váratlan válasz… 
újrapróbálkozás (n%))

Nem a várt érték lett beolvasva a készülékr l.
A rendszer visszavonásig vagy a sikeres 
kommunikáció létrejöttéig folyamatosan újra 
megkísérli a kommunikációt.
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Jelentés-létrehozási hibák

Több adatbejegyzés tartozik ugyanahhoz a dátumhoz

Ha ugyanazon készülék esetében ugyanahhoz a dátumhoz és 
id ponthoz több adatbejegyzés tartozik, a rendszer ezt feloldhatatlan 
ütközésnek érzékeli. Az ezekkel a készülékadatokkal létrehozott 
jelentésekben nem fognak szerepelni az egymással átfedésben lév
adatok. 

The communication device was 
found, but the pump (<serial #>) 
is not responding. Please verify 
the pump’s serial number, 
place the pump closer to the 
communication device to 
minimize interference, check 
pump battery and status. 
(A rendszer megtalálta 
a kommunikációs eszközt, de 
a pumpa (<sorozatszám>) nem 
válaszol. Ellen rizze a pumpa 
sorozatszámát, az interferencia 
minimalizálása érdekében 
helyezze a pumpát minél 
közelebb a kommunikációs 
eszközhöz, valamint ellen rizze 
a pumpa telepét és állapotát.)

Ellen rizze, hogy helyesen van-e megadva 
a pumpa sorozatszáma. Ha nem, adja meg a helyes 
sorozatszámot. Ha a sorozatszám helyes, helyezze 
közelebb a pumpát a kommunikációs eszközhöz, 
vagy tegye a kommunikációs eszközt és a pumpát 
az esetleg interferenciát okozó eszközökt l (például 
más rádiófrekvenciás eszközökt l) távolabbra, illetve 
ellen rizze a pumpa telepét és adagolási állapotát.

This pump is delivering a temp 
basal. Please cancel the temp 
basal or wait until it completes, 
and then try again. (Ez a pumpa 
éppen egy ideiglenes bázis 
beadását hajtja végre. Vonja 
vissza az ideiglenes bázist, vagy 
várja meg, amíg az befejez dik,
és próbálkozzon újra.)

Az olvasni kívánt pumpa éppen egy ideiglenes bázis 
beadását hajtja végre. Várja meg, amíg az ideiglenes 
bázis befejez dik, vagy vonja vissza az ideiglenes 
bázist, és olvassa le a pumpát.

This pump has active errors or 
alarms. Please clear the alarms 
and try again. (A pumpához 
aktív hibák vagy riasztások 
kapcsolódnak. Törölje 
a riasztásokat, majd 
próbálkozzon újra.)

A pumpához aktív riasztások tartoznak, melyek 
megakadályozzák a pumpa leolvasását. A riasztások 
törléséhez olvassa el a riasztásokra vonatkozó 
utasításokat. Törölje a riasztásokat, majd kísérelje 
meg ismét a pumpa leolvasását.

This pump is delivering a bolus. 
Please cancel the bolus or wait 
until it completes, and then try 
again. (Ez a pumpa éppen egy 
bolus beadását hajtja végre. 
Vonja vissza a bolust, vagy 
várja meg, amíg az befejez dik, 
és próbálkozzon újra.)

Az olvasni kívánt pumpa éppen egy bolus beadását 
hajtja végre. Várja meg, amíg a bolus befejez dik, 
vagy vonja vissza a bolust, és olvassa le a pumpát.

The device returned invalid 
entries; all data read will be 
discarded. (A készülék 
érvénytelen bejegyzéseket 
adott vissza; a rendszer az 
összes leolvasott adatot elveti.)

Kérje a helyi országos képviselet segítségét 
(lásd: Támogatás, 3. oldal).

Készülékleolvasási hiba Jelentés
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Próbálkozhat a jelentési id szak módosításával oly módon, hogy az ne 
tartalmazza az átfedésben lév  adatokat. Vagy azt is megteheti, hogy 
a korábban mért adatok törlése céljából a készüléket törli a rendszerb l,
majd ismét hozzáadja.

A rendszer figyelmen kívül hagy bizonyos adatokat

Ha a készülékid  megváltoztatása legalább háromórás id tartamra 
vonatkozó adathalmazban átfedést vagy hiányt okoz, a rendszer az 
érintett adatokat kihagyja a jelentések készítésekor.

Biztonsági mentéssel és visszaállítással 
kapcsolatos hibák

Az adatbázis nem zárolható

Ez akkor fordul el , ha többfelhasználós környezetben használja 
a rendszert, és más felhasználók is be vannak jelentkezve. A rendszer 
nem engedélyezi az adatbázis biztonsági mentését, miközben más 
felhasználók esetleg az adatbázist befolyásoló feladatokat hajtanak 
végre. Ha az összes felhasználó kilépett a CareLink Pro alkalmazásból, 
végrehajthatja az adatbázis biztonsági mentését.

Nem hajtható végre az adatbázis biztonsági mentése vagy visszaállítása

Más felhasználók nem tudnak bejelentkezni, és nem lehet biztonsági 
mentést vagy visszaállítást végrehajtani. Hívja a segélyvonalat, vagy 
lépjen kapcsolatba a helyi képviselettel (lásd: Támogatás, 3. oldal).

Nem sikerül az adatbázis visszaállítása

Az adatbázisról készült azon biztonsági másolat fájlja, amelyet 
a visszaállítási eljárás során használni kíván, sérült. A visszaállítást 
kísérelje meg egy másik biztonságimásolat-fájllal végrehajtani.

A szoftver eltávolítása

Ha a CareLink Pro eltávolítására van szükség, hajtsa végre az alábbi 
lépéseket:

1 Nyissa meg a Vezérl pultot a Windows Start menüjéb l.

2 Válassza a Add or Remove Programms (Programok telepítése és 
törlése) lehet séget. Ekkor megnyílik a Windows Programok telepítése 
és törlése segédprogramja.
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3 Görgessen lefelé, és jelölje ki a Medtronic Carelink Pro elemet.

4 Kattintson az REMOVE (Eltávolítás) gombra. Ekkor megjelenik az 
InstallShield varázsló.

5 Kattintson a NEXT (Tovább) gombra. Ekkor megjelenik egy üzenet, 
amely az alkalmazás eltávolításának a meger sítésére kéri.

6 Kattintson az YES (Igen) gombra. Az eltávolítóprogram törli az alkalmazást 
és az ahhoz tartozó összes fájlt a számítógépr l. A m velet befejez désekor
a varázsló egy üzenetben tájékoztat az eltávolítás végrehajtásáról.

7 Kattintson a FINISH (Befejezés) gombra.
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Ikontáblázat
A csomagolás címkéin és a készüléken lév  ikonok és szimbólumok 
magyarázata a következ  táblázatban látható:

Leírás Ikon

Dobozonként/csomagonként egy (1x)

Figyelem! Olvassa el a használati utasítást.

CD mellékelve

Fontos dokumentumok mellékelve

Katalógusszám REF

Kijelölt szervezet által CE jellel ellátott 
gyógyászati eszköz
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CSV-adatok A

Ez a függelék a CareLink™ Pro CSV formátumba történ  exportáláskor 
látható adatok leírását tartalmazza. 

Oszlopadatok jelentése

Oszlopfejléc Jelentés
Index (Mutató) Az adatok készülékben történt rögzítésének sorrendje.

Date (Dátum) Az adatok készülékben történt rögzítésének dátuma.

Time (Id pont) Az adatok készülékben történt rögzítésének id pontja.

New Device Time (Új készülékid ) Az új dátum és id , ha ezek módosultak a készülékben.

BG Reading 
(mg/dL or mmol/L) 
(VC-érték – mg/dl vagy mmol/l)

A mér eszköz, Guardian vagy pumpa által mért 
vércukorszintérték. Ha az adatok pumpából vagy 
Guardian készülékb l erednek, az oszlopban 
a kézi és a Link mér eszközb l származó 
vércukorszintértékek láthatók. 

Linked BG Meter ID 
(Csatlakoztatott VC-mér
azonosítója)

Azon mér eszköz sorozatszáma, amely egy bizonyos 
vércukorszintértéket a készülékre küld.

Basal Rate (U/h) 
(Bázisütem – E/ó)

Az aktív bázisinzulin adagolási üteme óránkénti 
egységszámban.

Temp Basal Amount 
(Ideiglenes bázis mennyisége) 

Ha ideiglenes bázist adagoltak a pumpával, ez az 
érték adja meg az ideiglenes bázis mennyiségét. 

Temp Basal Type 
(Ideiglenes bázis típusa)

Az ideiglenes bázis beállításának típusa (inzulinütem 
vagy a bázis százaléka).

Temp Basal Duration (m) 
(Ideiglenes bázis 
id tartama – perc)

Az ideiglenes bázisinzulin-adagolás (a típust lásd 
feljebb) id tartama percben.

Bolus Type 
(Bolus típusa)

A bolusinzulin adagolási típusa [Normal – Normál, 
Square – Négyszög, Dual (normal part) – Kéthullámú 
(normál rész) vagy Dual (square part) – Kéthullámú 
(négyszöghullámú rész)].

Bolus Volume Selected (U) 
(Választott bolusmennyiség – E)

A bolusinzulin-adagoláskor történ  beadásra kijelölt 
inzulinegységek száma.

Bolus Volume Delivered (U) 
(Beadott bolusmennyiség – E)

A bolusinzulin-adagoláskor ténylegesen beadott 
inzulinegységek száma.

Programmed Bolus Duration (h) 
(Programozott bolusid tartam – ó)

Négyszöghullámú bolus vagy kéthullámú bolus 
négyszöghullámú részének id tartama.
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Prime Type
(Feltöltés típusa)

Kézi vagy rögzített. A kézi feltöltés közvetlenül 
visszatekerés után történik az infúziós szerelék 
csövének inzulinnal való feltöltéséhez annak bekötése 
el tt. A rögzített feltöltés az infúziós szerelék bekötése 
után történik a puha kanül inzulinnal való feltöltése 
érdekében, a bevezet t  kivétele után.

Prime Volume Delivered (U) 
(Beadott feltöltési mennyiség – E)

A feltöltésként ténylegesen beadott inzulinegységek 
száma.

Alarm (Riasztás) A történt riasztás neve.

Suspend (Felfüggesztés) A pumpa felfüggesztett állapotának azonosítása.

Rewind (Visszatekerés) A készülék dátuma és ideje vissza lett tekerve.

BWZ Estimate (U)
(BWZ – becslés – E)

A bolusinzulin becslése, ha a számítás a Paradigm 
pumpa Bolus Wizard szolgáltatásával történt.

BWZ Target High BG 
(mg/dL or mmol/L) 
(BWZ – VC fels  célértéke – 
mg/dl vagy mmol/l)

A vércukor céltartományának fels  értéke, a Bolus 
Wizard szolgáltatás használja.

BWZ Target Low BG 
(mg/dL or mmol/L) 
(BWZ – VC alsó célértéke – 
mg/dl vagy mmol/l)

A vércukor céltartományának alsó értéke, a Bolus 
Wizard szolgáltatás használja.

BWZ Carb Ratio 
(BWZ – szénhidrátarány)

Az inzulin-szénhidrát arány értéke. Ha az egység 
a gramm, akkor az arány azt jelenti, hogy hány 
gramm szénhidrátot kompenzál egy egységnyi 
inzulin. Ha az egység a csere, akkor az arány azt 
jelenti, hogy hány egységnyi inzulin használatos egy 
csereegység szénhidrát kompenzálásához.

BWZ Insulin Sensitivity 
(BWZ – inzulinérzékenység)

Az inzulinérzékenység beállítása. Az 
inzulinérzékenység az az érték, mellyel 
a vércukorszint egy egységnyi inzulin hatására 
csökken. Ezt a Bolus Wizard szolgáltatás használja.

BWZ Carb Input 
(BWZ – szénhidrát megadása)

A Bolus Wizard szolgáltatásban megadott, illetve 
a bolusbecsléshez használt szénhidrátmennyiség.

BWZ BG Input 
(mg/dL or mmol/L) 
(BWZ – VC megadása – 
mg/dl vagy mmol/l)

A Bolus Wizard szolgáltatásban megadott, illetve 
a bolusbecsléshez használt vércukorérték.

BWZ Correction Estimate (U) 
(BWZ – korrekciós becslés – E)

A vércukorszint korrigálása érdekében beadandó 
bolusinzulin egységszáma a Bolus Wizard számítása 
szerint.

BWZ Food Estimate (U) 
(BWZ – étkezési becslés – E)

A várható szénhidrátfogyasztás kompenzálása 
érdekében beadandó bolusinzulin egységszáma 
a Bolus Wizard számítása szerint.

BWZ Active Insulin (U) 
(BWZ – aktív inzulin – E)

A korábbi bolusinzulin-adagolásokból az aktív inzulin 
testben maradó mennyiségének számított értéke, ha 
a becsült bolusmennyiség meghatározása a Bolus 
Wizard szolgáltatással történik.

Sensor Calibration BG
(mg/dL or mmol/L) 
(Szenzorkalibrálási VC – 
mg/dl vagy mmol/l)

A szenzor kalibrálásához használt vércukorszint 
mg/dl-ben vagy mmol/l-ben.

Sensor Glucose 
(mg/dL or mmol/L)
(Szenzor glükózértéke – 
mg/dl vagy mmol/l)

A szenzor által mért glükózérték.

ISIG value 
(ISIG érték)

A szenzorról leolvasott, nanoamperben (nA) mért 
bemen  jelek (ISIG).

Oszlopfejléc Jelentés



CareLink Pro™ – használati útmutató          68

További tudnivalók a CareLink Pro által exportált 
CSV-fájlokról

A CSV-fájl tetején látható cím a következ ket tartalmazza:

• a beteg neve
• a kiválasztott készülékek és sorozatszámaik listája
• a kiválasztott dátumtartomány

Az egyes oszlopblokkoknak is van címe, amely a következ ket
tartalmazza:

• azon eszköz neve, amelyre az adatok vonatkoznak
• ezen eszköz sorozatszáma 

Ha az adatok nem a várt módon jelennek meg

Több tényez  is szerepet játszhat abban, ha a CSV-adatok a várttól 
eltér en jelennek meg.

• Az eszköz dátumának és idejének változása hatására módosulhat 
a sorrend, illetve a kijelölt dátumtartományon kívüli adatok is 
megjelenhetnek.

• Ha hosszú id  telik el a készülékleolvasások között, akkor a készülékre 
vonatkozó adatok több blokkban jelenhetnek meg.
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Sz
ós

ze
de

t

Szószedet

A
A/B séma A napi ritmustól eltér , de a szokásos életstílussal 
összeegyeztethet  aktivitásszintekhez tartozó bázisséma. Ilyen például 
a heti egyszeri sportolás, az alvási szokások változása a hétvégén, 
a hosszabb ideig tartó fokozott vagy csökkent aktivitás, továbbá 
a menstruációs id szak.
A1c  Glikozilált hemoglobin.
A1c mérése  A hemoglobin A1c mérése, amellyel egy id szakra 
vonatkozóan követhet  a vércukorszint.
alacsony glükóz  A pumpa figyelmeztet, ha a szenzor észlelése 
szerint a felhasználó glükózszintje erre az értékre vagy ez alá csökken. 
Ez a funkció ki-be kapcsolható.
alacsony tartályszint jelzése  Programozható jelzés, amely értesíti, 
ha már csak adott számú egység van a pumpa tartályában, illetve ha 
már csak adott id tartam van hátra a tartály kiürüléséig.

B
bázisinzulin  Óránkénti, folyamatosan adagolt inzulin, amelyet az 
inzulinpumpa automatikusan ad be a pumpán beállított el re programozott 
profilok és személyre szabott ütemek alapján. A pumpa adagol egy napi 
inzulinmennyiséget, amely általában fedezi a háttérinzulinszintet az 
étkezésmentes id szakokra (például éjszakára és az étkezések között).
bázisprofil  Kezd - és záróid ponttal rendelkez  bázisütem. 
A felhasználó egy 24 órás id szakra több különböz  profilt 
programozhat be a pumpán eltér  bázisütemekkel a jobb 
vércukorszint-szabályozás érdekében.
bázissémák  A felhasználó legfeljebb három különböz
bázisütemsémát programozhat be a pumpán a bázisinzulin 
beadásához: Standard (Normál), A és B. Az egyes sémákhoz 
legfeljebb 48 bázisütem állítható be.
bázisütem  A pumpa azon beállítása, mely folyamatos inzulininfúziót 
tart fenn, ezáltal stabilan tartja a vércukrot az étkezések között és 
éjszaka. A bázisinzulin a hasnyálmirigy inzulintermelését utánozza, 
így fedezi a szervezet nem táplálékhoz kötött inzulinszükségletét.
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bolusinzulin  Egy adag inzulin, mely a várható (például étkezés utáni) 
vércukor-emelkedést kompenzálja, vagy a céltartományba csökkenti 
a magas vércukorértéket.

C
CareLink™ Personal Online szolgáltatás, amely lehet vé teszi 
a diabéteszadatok kezelését az interneten.

CareLink™ USB Készülék, amely a Medtronic Diabetes Paradigm 
sorozatú inzulinpumpákban vagy a Guardian REAL-TIME 
monitorokban tárolt adatoknak a CareLink™ szoftverbe való, 
a számítógép egy USB-portján keresztüli feltöltésére használatos.
Com-Station  Olyan eszköz, amellyel a MiniMed 508 pumpa és 
a küls  cégek által gyártott mér eszközök átmen  adatai letölthet k
a számítógépre.
ComLink  Rádiófrekvenciás adó-vev  készülék, amellyel a Paradigm 
pumpa vagy a Guardian REAL-Time CGM rendszer adatai letölthet k
a számítógépre.
csatlakozás  A mér opció bekapcsolása és beállítása, miáltal a pumpa 
fogadhatja a CONTOUR® LINK, a OneTouch® UltraLink™ vagy 
a Paradigm Link® mér eszköz által végzett vércukormérés eredményeit.   
cserearány  Az az inzulinmennyiség, amely egy (1) csereegység 
szénhidrát kompenzálásához szükséges. (Lásd még: CH-arány.)

D
Dual Wave® (kéthullámú) bolus  Az azonnal adagolt normál bolus 
és az azt követ  Square Wave (négyszöghullámú) bolus kombinációja. 
A négyszöghullámú rész adagolása adott id tartamon belül egyenletes.

E
Easy Bolus™  (Egyszer  bolus) A normál bolus beadásának módja 
az Easy Bolus gomb megnyomásával a pumpán.
étkezési bolus  Az az inzulinadag, amely kompenzálja az étkezések 
után várhatóan bekövetkez  vércukor-emelkedést.
expressz bolus  Bármely típusú bolus beadásának módja a pumpa 
Express bolus gombjának megnyomásával.

F
felfüggesztés  A pumpa azon funkciója, amely minden inzulinadagolást 
leállít. Minden aktuális bolusbeadás és/vagy feltöltés megszakad. 
A bázis adagolása újraindításig szünetel. 
feltöltés  A pumpa vagy mér eszköz adatainak átvitele a CareLink™

Personal kiszolgálóra.
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G
görbe alatti átlagos terület  A magas és az alacsony vércukorszint 
(hiperglikémia és hipoglikémia) átlagos hatása a szenzor általi átvitel 
id tartama alatt.

H
hangjelzéses bolus  A pumpa beprogramozható úgy, hogy a felhasználó 
csipogást halljon egy beadandó bolusinzulin-mennyiség (például 0,5 vagy 
1,0 egység) kiválasztásakor. Ez olyan helyzetekben hasznos, amikor 
a pumpa gombjai nem láthatók jól.
HbA1c  Glikozilált hemoglobin.
HbA1c mérése  A hemoglobin A1c mérése, amellyel a vércukor-
szabályozás vagy a szintek átlaga mérhet  egy 2-3 hónapos id szakra 
vonatkozóan.
hiperglikémia Megemelkedett vércukorszint, amely vércukorszintméréssel 
mutatható ki, és a következ  tünetek kísérhetik: hányinger, hányás, 
homályos látás, fejfájás, gyomorbántalmak, gyakori és nagy mennyiség
vizeletürítés, valamint levertség. 
hipoglikémia  Alacsony vércukorszint, amely vércukorszintméréssel 
mutatható ki, és a következ  tünetek kísérhetik: túlzott éhség, remegés 
vagy reszketés, izzadás, „táncoló” látás, szédülés, fejfájás, zavaros 
beszéd, hirtelen hangulatváltások, valamint személyiségváltozás.

CH
CH  Szénhidrát.
CH-arány (szénhidrátarány) Az a szénhidrátmennyiség, melyet egy 
egységnyi inzulin kompenzál. (Lásd még: cserearány.)
CH-egység  A táplálékbevitel a Bolus Wizard használatakor. Megadható 
(szénhidrát) grammban vagy csereegységben.

I
ideiglenes  Átmeneti.
ideiglenes bázis  Ideiglenes, egyszeri bázisinzulin megadott adagban 
és id tartamig. A speciális, nem mindennapos tevékenységekkel vagy 
állapotokkal járó inzulinszükségletet elégíti ki.
infúziós szerelék  Olyan eszköz, amellyel a kanül beilleszthet  és 
rögzíthet  a b r alatt, valamint az inzulin csöveken át a pumpából 
a bevezetési helyre továbbítható.
inzulinérzékenység  Az az érték (mg/dl-ben vagy mmol/l-ben), mellyel 
a vércukorszint (VC) egy egységnyi inzulin hatására csökken. 
(A Bolus Wizard adata.)
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inzulinkoncentráció  Az orvos által a felhasználó számára el írt 
er sség  vagy típusú inzulin. Ez hatással van a pumpa által beadott 
inzulin ütemére. Ha a felhasználó inzulinkoncentrációja változik, 
a bázissémákat, valamint a maximális bázis- és bolusütemeket 
újra kell programozni a pumpán.

K
kalibrálásra való figyelmeztetés   A Kal.-figyelm. érték az az id tartam,
amennyivel a jelenlegi kalibrációs érték érvényességének lejárta el tt
a felhasználó figyelmeztetést szeretne kapni a pumpától az újabb 
kalibrálásra egy VC MÉRÉS értesítés képében. Ha például a Kal.-figyelm. 
érték két órára van állítva, a VC MÉRÉS értesítés két órával a kalibráció 
tervezett id pontja el tt aktiválódik.
kézi bolus  (Manual Bolus) A Bolus menü egyik választható eleme, 
ha a Bolus Wizard szolgáltatás aktív. A bolusprogramozás egyik, 
a Bolus Wizard használata nélküli módja. 
ketonellen rzés  A keton olyan melléktermék, amely akkor jön létre, 
ha a szervezet arra kényszerül, hogy cukor helyett zsírt égessen 
az energianyeréshez. Ez jelezhet inzulinhiányt a szervezetben. 
A ketonellen rzés a vérben vagy a vizeletben méri a ketonkoncentrációt.
korrekciós bolus  Az az inzulinmennyiség, mely a magas 
vércukorszint céltartományba való csökkentéséhez szükséges.
korrekciós tényez  (érzékenységi tényez ) Az a mennyiség, 
amellyel a vércukor 1,0 egység inzulin hatására csökken. Ez a tényez
használható a korrekciós bolus mennyiségének kiszámítására, ha 
magas a vércukorszint.
(VC-szint) - (VC-cél) = X 
X ÷ (korrekciós tényez ) = 
korrekciós bolus mennyisége

L
lépés  Az inzulin növekménye, melyet az Easy Bolus szolgáltatással 
történ  beadáshoz lehet beállítani és használni.

M
magas glükóz  A pumpa figyelmeztet, ha a szenzor észlelése 
szerint a felhasználó glükózszintje eléri vagy túllépi ezt az értéket. 
Ez a funkció ki-be kapcsolható.
maximális bázisinzulin  Az a maximális mennyiség  bázisinzulin, 
amelyet a pumpa egyszerre ad le. (Az értéket a felhasználó állítja be.)
maximális bolus  Az a maximális mennyiség  bolusinzulin, amelyet 
a pumpa egyszerre ad le. (Az értéket a felhasználó állítja be.)
mér eszköz Olyan orvosi eszköz, amellyel megközelít leg meghatározható 
a vércukor koncentrációja. A vizsgálathoz vércseppet helyeznek egy 
egyszerhasználatos tesztszalagra, amelyet a mér eszköz leolvas, 
majd ez alapján kiszámítja a vércukorszintet. A mér eszköz mg/dl-ben 
vagy mmol/l-ben adja meg a szintet. 
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mér opció Olyan szolgáltatás, amellyel engedélyezhet , hogy 
a pumpa fogadja egy csatlakoztatott vércukormér  eszköz által 
mért vércukorértékeket.
μl mikroliter  

N
négyszöghullámú rész  (Sq) A kéthullámú bolus második része. 
A négyszöghullámú rész adagolása az azonnali adagrész beadása 
után, egyenletesen, adott ideig történik.
normál bolus  Adott egységnyi inzulin azonnali beadása. 

R
RF  Rádiófrekvenciás. 

S
Square Wave® bolus  (Négyszöghullámú bolus) Egyenletesen, 
a felhasználó által megadott ideig (30 perc-8 óra) adagolt bolus. 
Standard séma  A normál bázis a szokásos napi tevékenységekhez. 
Ha a sémaszolgáltatás ki van kapcsolva, a pumpa a normál sémát 
használja.

T
távadó azonosítója   Az éppen használatban lév  távadó sorozatszáma.

V
VC Vércukor.
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rendszer nem érhet  el 58
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másolattal 58
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aktiválás, készülékek 40
alapfunkciók, CareLink Pro 2
alapvet  CareLink Pro-feladatok 16
alkalmazás, használati útmutató 5
alkalmazási terület 6

Á
állapotsor, CareLink Pro 9
általános beállítások

megadás 18
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B
beállítások
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rendszer

értelmezés 18
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adatok kiválasztása 21
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a CareLink Pro szoftverbe 8
beolvasás, a beteg készülékének 

adatai 41
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e-mail meghívó 28
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biztonsági mentés, adatbázis 57
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CareLink Personal

adatok beolvasása 29
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dátumok 50
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kommunikációs eszközök CareLink 
Pro-támogatással 4
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támogatott 3
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Medtronic MiniMed-termékek
megrendelés 5
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kapcsolódás 26

megnyitás
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megnyitás, beteg beállításai
megadás

adatok kiválasztása 21
megnyitás, betegprofilok 17
megnyitás, CareLink Pro 8

bejelentkezés 8
jelszó beírása 8

megrendelés
készülékek 5
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mér eszközök 5
pumpák 5

megtekintés
jelentések 51
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mentés
jelentések 51

menüsor, CareLink Pro 12
mér eszköz, kábel 4
mér eszköz, név

helyettesít  készülékek 5
mér eszköz, támogatott adatátviteli 

kábel 4, 5
mér eszközök

aktiválás 40
beállítások a számítógéppel 

történ  kommunikációhoz 33
beolvasás, adatok 41
csatlakoztatás

a számítógéphez 31
kábelek

soros 32
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kiegészít  tartozékok
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Com-Station 33

mér opciók 33
számítógépes kapcsolatok
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hozzáadás a rendszerhez 38
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ismertetés 53
naplójelentés

ismertetés 52
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navigálás
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adatmez k kiválasztása 20
egyéni mez
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segélyvonal 3

telefonszámok 3
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kommunikációs eszközök 4
mér eszköz átviteli kábele 4
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